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Introduction 
Camtasia Relay provides an excellent way to capture lectures and presentations. It was designed to be easy to use, 
easy to administer, and to be easy on the budget. To implement Camtasia Relay successfully, it is helpful to 
understand the architecture of the product and ways to make it as effective as possible. 

This Document 

The purpose of this document is to provide a more in-depth examination of Camtasia Relay, including the overall 
architecture, planning information, sizing and performance considerations, security principles, tips on integrating 
Camtasia Relay with other products, and general best practices. 

Use this guide as a reference, as a how-to manual, and as a resource to help you successfully implement lecture 
capture. 

The Camtasia Relay team plans to update this document as needed. You can always access the latest PDF on the 
Camtasia Relay documentation page : 
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA 

Additional information about Camtasia Relay can be found at these locations: 

 For day-to-day administration of Camtasia Relay, please see the Camtasia Relay Website Help. This help is 
available after logging into the Camtasia Relay website as an administrator or as a PDF online. 

 For help with the Camtasia Relay recorder, please see help in the recorder or visit the tutorials on the TechSmith 
website. 

 For installation and upgrade information and documentation, see the Camtasia Relay documentation page in the 
support section of the TechSmith website. 

 For technical support please refer to the section TechSmith Tech Support on page 101. 

 For sales information or to request a trial, please contact Sales at 
http://www.techsmith.com/company/contact/salescontact.asp 

Feedback 

If you would like to offer feedback on or suggestions of topics to cover in this or any other Camtasia Relay 
documentation, please send an email to relayhelp@techsmith.com. 

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
http://www.techsmith.com/company/contact/salescontact.asp
mailto:relayhelp@techsmith.com
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Camtasia Relay Overview 
With Camtasia Relay, you can capture and publish your lecture or presentation anytime, anywhere -- in the 
classroom, in the conference room, at your desk, or at home. Camtasia Relay supports a wide variety of video formats 
allowing any lecture or presentation to be viewed by your audience on multiple playback devices including portable 
media devices such as the Apple iPod and via iTunes U. 

Camtasia Relay processing involves two different computers --the recorder, which runs on a presenter‘s computer, 
and the server which processes and publishes all presentations. 

The presenter presses the Record button on a PC or Mac and gives a presentation. When done, the presenter 
presses Stop to end the recording, optionally trims the beginning and end of the recording, and then presses Submit 
to upload the recorded presentation to the Camtasia Relay server. At this point, the presenter is done with their part of 
the process. 

At the server, submitted recordings arrive from different presenters. Each is processed according to a selected profile. 
The profile determines how the presentation is encoded for playback. A profile could, for example, indicate that a 
presentation is to be encoded for playback on the web, on an iPod, or various other locations. 

Once a presentation is encoded, it is published according to what was specified in the profile. Once published, the 
process is complete and the presentation is ready for viewing. 
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System Architecture 
The main components of the Camtasia Relay system are the server, which can run on a server or multiple servers, 
and the recorders, which run on the presenter‘s computer or from a portable media device, and are available on both 
the Microsoft Windows and Mac operating systems. 

The Camtasia Relay server has multiple functions including acting as a website, a transcoding server, and a 
publishing agent .  The Camtasia Relay server does not host the media it produces but can push it out to various 
destinations including iTunes U, Screencast.com, YouTube, FTP/sFTP destinations, Windows File Shares, and 
WebDAV enabled destinations. 

The following diagram relates the basic architecture of the Camtasia Relay system. It shows both the main 
components described above and the supporting components of Camtasia Relay. 
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Planning, Installation, and Initial 
Configuration 

Site Planning 
When planning for installation, the following diagrams can help give you an idea of the setup of the Camtasia Relay 
system for a few different environments. 
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If the SQL Server, LDAP server, and file system servers are in a publicly accessible network, then the connection to 
these servers should be encrypted using SSL or IPSec. 

Camtasia Relay Server should be deployed in a demilitarized zone (DMZ) in your network and this DMZ should be 
physically or logically segmented from the internal network by a stateful packet inspection (SPI) firewall or other 
network security device.  The point-to-point communication between any Camtasia Relay Servers and the remote 
SQL / LDAP (and maybe file system) server should not be across any public network.  The remote server should be 
placed in a more secure portion of your network than the DMZ and should not be publicly accessible, if possible. 
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Installation 
The installation of Camtasia Relay is important enough to have its own document. A link to the Installation guide and 

other resources can be found in the Appendix A: Additional Help and Related Documentation on page 104. 

Set Up a Testing/Practice Server 
When you purchase Camtasia Relay, your activation code allows you to have one separate server you can use for 
testing. The following procedure describes how to create a test server and populate it with current data from your 
production server. 

 Before beginning, you should have SQL Server Management Studio installed on both servers. 

On the Current Production Server 

1. Log in to the Camtasia Relay website as an administrator. 

2. Go System > Activation and write down your license key. You will use this same license key on the test server. 

3. Back up the Camtasia Relay database. 
For more instructions on how to back up the Camtasia Relay database please refer to section Back Up the 
Camtasia Relay Database on page 71. 

4. Copy the backup file to the new test server. 

5. Copy the contents of the media directory from the production server to the test server. 

  The media directory on the new server must be the same as the old server. 

On the New Test Server 

1. Install Camtasia Relay on the test server. Make sure to set the media directory the same as what it is on the 
production server. 

2. Go to System > Activation and enter your license key. 

3. Stop the Relay Manager Service and IIS. 

4. To stop the Relay Manager Service, open a command prompt and type: 

net stop "Relay Manager Service" 

5. To stop IIS, type: 

iisreset /stop 

6. Restore the Relay database. 
For more instructions on how to restore the Camtasia Relay database please refer to the section Restore the 
Camtasia Relay Database on page 76. 

7. In the Object Explorer pane of SQL Server Management Studio, go to  
Relay Database Instance >Databases > Relay > Security > Users. 

8. Right-click the relay user and select Delete. 

9. In the Object Explorer pane, go to Relay Database Instance > Security > Logins. 

10. Right-click the relay user and select Properties. 

11. In the Login Properties window, select the User Mapping page. 
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12. Assign the relay user within SQL Server to the Relay user inside of the Relay database. 

 The user must have db_datawriter, db_datareader, and sql_dependency_subscriber permissions. 
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13. Assign the proper roles to the RelayCache user within SQL Server. 

 The user must have sql_dependency_starter permissions. 

 

14. In the Object Explorer pane, go to Relay Database Instance>Databases > Relay > Tables. 

15. Right-click dbo.tblEndpoint and select Open table. 

16. The data from the table is shown in the right pane.  Update the edptUrl field to be the proper URL of the new 
server. 

This is the same url that you entered into the installer for their SSL certificate, but here you need the full url.  For 

example, if you used relay.example.com, here you need to enter: 
https://relay.example.com/relay/rest.ashx. 
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17. Click off the row or press the down arrow to confirm and save the change. 

 

18. To restart the Relay Manager Service, in the command prompt, type: 

net start "Relay Manager Service" 

19. To restart IIS, type: 

iisreset /start 

20. Log into the website as an administrator and go to System > Servers. 

21. If needed, select the server and click Bring Server Online. 

Activate / Deactivate Camtasia Relay Server 
Activate Camtasia Relay server to remove the trial period and activate the correct number of encoding processors. It 
is important to deactivate Camtasia Relay server before you uninstall the server so you can install Camtasia Relay on 
a different server. 

 To communicate with the activation server through a firewall, port 80 must be open. Please refer to the Firewall  
Rules  section of the Camtasia Relay Server Security Administrat ion Guide  referenced in 
Appendix A: Additional Help and Related Documentation on page 104. 

Activate the Camtasia Relay Server 
1. Click System > Activation. 

2. Enter your License code and click Activate. 

Obtaining More Activations 
If you find that you need additional activations for your server(s), please contact a sales associate; we will walk you 
through the process of updating your license. 

Please refer to section TechSmith Sales Support on page 100. 

Offline Activation/Deactivation 
If Camtasia Relay is installed on a private network, offline activation/deactivation allows you to deactivate without 
connecting to the Internet. 
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To activate when offline: 

1. Log in to the Camtasia Relay website as an admin and go to System > Activation. 

2. Click Offline Activation. 

3. A window opens and contains an Installation ID number. 

4. Contact a TechSmith sales associate. 

Please refer to section TechSmith Sales Support on page 100. 

5.  Provide the Installation ID and License code to the sales associate. The sales associate gives you an Unlock 
Code. 

 Your license code was emailed in the Camtasia Relay purchase receipt. 

6. Enter the code into the field provided. Camtasia Relay is now activated. 

To deactivate when offline: 

1. Log in to the Camtasia Relay website as an admin and go to System > Activation. 

2. Click Offline Activation. 

3. A window opens. Click Deactivate to deactivate the server. 

4. The window closes and you return to page. The server is now shown in an Expired state. 

5. Contact a TechSmith sales associate. 

Please refer to section TechSmith Sales Support on page 100. 

6. Provide the Proof of Removal code and the Installation ID to the sales associate.  This will decrement the number 
of activations on your license code in the event that you want to activate a different server. 

Problems with Activation/Deactivation 
In the event of hardware failure or problems, please contact TechSmith Tech Support. 

Please refer to section TechSmith Sales Support on page 100. 

Please be ready with your Installation ID, License code (or Proof of removal code in the case of deactivation). 
Your license code was emailed in the Camtasia Relay purchase receipt. 

Post-Install Configuration 
When the install completes, log in to the Camtasia Relay website with the relayadmin account. You now need to 

configure the server. 

Email Server Configuration 
When you first log in, you are directed to a page to configure the email server. Camtasia Relay uses the email server 
to notify designated Camtasia Relay Administrators of server and presentation problems. Camtasia Relay also emails 
presenters when their presentations are published. 

 If you do not know the email server address, you can skip this step and enter it after Camtasia Relay is 
completely installed. (System > Email Server Configuration). 

 The configuration includes: 
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 The SMTP email server address. (Required) 

 The SMTP email server port. 

 The email address that shows in the Reply To field of email notifications. 

 The email address of the Relay Administrator user. This email address will receive notifications from the server 
when action is needed from an administrator. (Required) 

 If you change the email address in the Relay Admin user email field, the email address associated with the 
Relay Administrator user will also be changed. Likewise, if you edit the email address of the Relay 
Administrator on the Users page, this email address will also change. 

Configuration Steps 
Next, you will see the Server Dashboard page. This page shows the major steps to configure Camtasia Relay. Full 
configuration instructions are provided in the Camtasia Relay Administrator Website Help, which can also be 
downloaded as a PDF. For more information on how to access this help file, see Appendix A: Additional Help and 
Related Documentation on page 104. 

Roll Out Camtasia Relay to Presenters 
The best way to cut down on administration time with Camtasia Relay is to help the presenters learn how to help 
themselves. One good way to do this is to have a good plan of how to introduce them to Camtasia Relay. 

Here‘s a checklist of suggested steps when introducing Camtasia Relay to presenters. 

 Verify all presenters have valid profiles associated with their accounts. 

 You might wish to roll out Camtasia Relay in stages. For example, start with one department instead of the whole 
company or campus. 

 What training will presenters require? You can direct presenters to the overview video launched from the help 
menu of the recorder and the videos located in the Help section of the Camtasia Relay website. (Administrators 
see a different help page.) 

 Decide if you will install the Camtasia Relay recorder on user computers or if you will direct users to obtain and 
install the recorder on their own. The recorder has the Camtasia Relay server URL ―baked-in‖ based on the server 
from which it was downloaded. If you put a copy of the Camtasia Relay recorder on a website or network drive 
make sure you got it from the server you want people to use. 

 Establish a clear policy for how presenters should do things like request new profiles or profile changes or request 
a new password. 

 Prepare an introduction email for presenters. We have created a few samples you can modify. You can find these 
samples by logging in to the Camtasia Relay website as an administrator, click Help to open the Help File, and 
search for ―sample email‖. 

What Presenters Need to Know Most 
You need to communicate the following to presenters. You can use this information in an email introducing Camtasia 
Relay to your presenters. 

There are helpful videos. 

Get Presenters to watch the overview accessible from the login screen of the recorder and in the Help section on the 
Camtasia Relay website. You may want to send presenters directly to the video at the following URL so they can 
review Camtasia Relay before accessing the Recorder or having to sign in to the Camtasia Relay website: 
http://www.techsmith.com/redirect.asp?product=relay&ver=2.0.0&lang=enu&target=getting-started-recorder. 

Make a test recording. 

There is a blue TEST button in the Camtasia Relay recorder presenters can use to verify that they are recording the 
correct screen and that the audio is recording properly. 

How uploading works. 

http://www.techsmith.com/redirect.asp?product=relay&ver=2.0.0&lang=enu&target=getting-started-recorder
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As soon as the presenter clicks the Submit button in the recorder, Camtasia Relay prepares the recording for 
uploading in the background. 

 There is no visual indication of the progress of the upload to the submitter. 

 If the recorder is offline (or loses Internet access), the recording automatically uploads (or resumes uploading) as 
soon as the computer gains Internet access. 

 Presenters receive an email when the presentation is published. 

 Presenters can check the upload, encoding and publishing progress if they log in to the Camtasia Relay website. 
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Profiles 
All presenters must select a Profile before they can upload their presentations to the server. Profiles determine record 
quality, encoding format(s) and publish destination(s). Only Camtasia Relay Administrators can create and modify 
profiles. 

Good Profile Naming 

Before naming profiles, remember that presenters choose which profile to use by title only. You will want to consider 
carefully how you will name profiles. The profile title is the only thing presenters can see in the recorder. The profile 
description is only visible on the website. 

 Good example names: CHM-141, BIO-101, Quarterly reports, Personal Recordings 

 Not-so-good example names: MP4 output, John Presenter, 10142 

The Sample Profile 
Upon completing a new install of Camtasia Relay and completing the Email Server Configuration, a new sample 
profile called "Sample Profile" is created. The sample profile produces one flash output published to Screencast.com, 
using the default account specified on the Profiles > Publish Account Setup page. 

The profile's description explains its usage: 

 This sample profile publishes to Screencast.com using the default account. You can make it functional, use it for 
reference purposes, or delete it. 

 To make it functional: verify the Notification Email Server configuration is correct and associate a presenter user 
to this profile. Before the presentation can publish, you need to provide valid Screencast.com account credentials. 

If the sample profile is tested before the administrator has supplied credentials for the default Screencast.com 
account, an error is displayed saying "The profile is missing account information." 

To remedy this, go to the Profiles > Publish Account Setup and enter credentials for a default Screencast.com 
account. Save and try testing the sample profile again. 

The Upload and Decide Later Profile 
The Camtasia Relay recorder comes with an Upload and Decide Later Profile. This profile sends the recording to the 
Camtasia Relay server, but the recording is not processed in any way. It stays in the Needs Attention state on the 
server until an authorized presenter or Camtasia Relay administrator assigns a different profile and submits the 
recording for publishing via the Camtasia Relay website. 

The Upload and Decide Later profile is primarily used by guest presenters and authorized presenters who do not 
know their password. 

Why Use the Upload and Decide Later Profile? 

 For guest presenters, it is the only profile available. 

 You make a presentation in advance, but do not want it published until later. 

 You are not satisfied with existing profile options and wish to hold the recording on the server until you can 
contact your Camtasia Relay administrator to create or modify a profile. 

For additional information on setting up profiles, please log into the Camtasia Relay website as an administrator and 
click Help. 
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The Profile Test 
The Profile Test is enabled for a profile when the profile is valid (i.e., the profile has no red-coded items). 

 

When you click the Test Profile button, a sample presentation is created and processed for a built-in sample video. 
Any credentials and profile variables needed by profile are based on the specified Test Presenter. 

If any credentials or variables cannot be resolved based on the specified user, the presentation fails and an error 
message is displayed. 

The test presentation is prepared like regularly uploaded presentations. This includes the creation of encoding, 
transcription (if selected in the profile), publishing, and notification (if selected on the Profile Test page) jobs. 

These jobs can be monitored from the Presentations page. The Profile Test page is automatically redirected to the 
Presentations page after the test presentation successfully begins. 
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Encodings 

Encoding Types 

Preset Format 
Includes 
Camera 

PIP? 
Where it Excels 

AVI (Original Size) AVI No This encode setting produces a single AVI file with 
the same resolution as the original recording. Use 
this file if you want to perform your own video 
processing and encoding. Note that AVI files 
usually have a larger file size than presentations 
encoded in other formats. 

Camtasia Studio 
Recording (Original 
size, i.e. full-screen)  

CAMREC Yes This encode setting generates a .camrec file for 
use with Camtasia Studio version 5.1 and later. 
The .camrec file contains PowerPoint and Keynote 
slide and title clip markers. This encoding should 
only be given to presenters with access to 
Camtasia Studio. 

When publishing a .camrec file to a location with a 
valid web url, the resulting notification includes a 
―View‖ link. Because web servers do not have a 
MIME type set up for .camrec files, the link leads to 
a 404 error page. 

Camtasia for Mac 
Recording 

ZIP > CMPROJ No This encode setting generates a lossless video file 
for editing within Camtasia for Mac. This encoding 
should only be given to presenters with access to 
Camtasia for Mac. The resulting file is a ZIP file 
that, when opened on a Mac, automatically unzips 
into a directory. The user can double-click that 
directory to launch the CMPROJ in Camtasia for 
Mac.  

Flash  

 (Small) 640x480  

 (Medium) 800x600  

 (Large) 1024x768 

(Original Size)  

MP4 Yes This encode setting creates video files that play in 
a Flash controller (SWF). The controller supports a 
table of contents based on the titles of slides in a 
PowerPoint or Keynote presentation.  

Also supports searching slide text, full audio 
search, and captions, if enabled.  

iPad MP4 Yes This encode setting creates video files with varied 
final resolutions to provide the best viewing 
experience for a given video on an iPad. The 
resolution is calculated to provide the best 
resolution to view the video at 15 frames per 
second. 

iPod and iPhone MP4 Yes This encode setting works on all iPods and iPhones 
that support video of any kind. The final resolution 
of the video is fixed at 640 x 480. Video looks good 
on all iPods and iPhones, but does not look good if 
played in QuickTime on a desktop computer. 
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Preset Format 
Includes 
Camera 

PIP? 
Where it Excels 

MP3 (Phone Quality)  MP3 No This is an audio-only encode setting. The server 
can process this encoding extremely fast, and the 
resulting file size is very small. This is a good 
encode setting for those who may want an audio-
only version of their presentation. 

MP4 (Original Size) MP4 Yes This encode setting creates an MP4 video file with 
no additional files. The file is the same dimensions 
as the original recording. 

Original Recording 
(Backup)  

AVI (Windows)  

MOV 
(Macintosh) 

Recording 
and camera 
video are 
save as two 
separate 
files 

This encode setting does not modify the original 
recorded file in any way. The file size is enormous 
and usually not considered viewer-friendly. Use this 
setting if you need a copy of original files for 
backup purposes or troubleshooting. 

Real Media  

 (Small) 640x480  

 (Medium) 800x600  

Large) 1024x768  

RMVB No Generates a Real Media file. Can be used in 
conjunction with Real Media servers, such as a 
Helix Server. 

Silverlight  

 (Small) 640x480 

(Medium) 800x600  

(Large) 1024x768  

 (Original Size)  

XAP Yes This encode setting creates video files that play in 
Microsoft Silverlight. The controller supports a table 
of contents based on the titles of slides in a 
PowerPoint or Keynote presentation. Also supports 
searching slide text, full audio search, and 
captions, if enabled.  

Windows Media  

(Small) 640x480  

 (Medium) 800x600  

 (Large) 1024x768  

 (Original Size)  

WMV Yes This encode setting creates video files that play in 
Windows Media Player. The video files tend to be 
larger than the Flash and Silverlight encodings, but 
may be preferred by Windows users with high 
speed internet access. 

Windows Portable 
Media Device 

WMV No This encoding is designed to provide the best 
solution for Windows Mobile Devices (Pocket PCs) 
and some Windows-based Smartphones. 

YouTube (Original Size) MP4 Yes  This encoding is only available for the 
YouTube publish destination.  

This is used for publishing directly to YouTube 
using the YouTube publishing plug-in. 

The video is subject to YouTube‘s file restrictions. 
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Encoding Sizes and Aspect Ratios 

What Do Small, Medium, and Large Really Mean? 

The Flash, Silverlight, Windows Media, and Real Media output have various resolutions available to each of them that 
are labeled Small, Medium, and Large.  What do these resolutions mean?  These resolutions are adaptive in that they 
will automatically adjust to the aspect ratio of the recorded resolution. 

The following images show examples of each of these aspect ratios. 

Example Examples 

 

640x480 
800x600 
1024x768 
1152x864 
1280x960 
1600x1200 

 

1280x800 
1440x900 
1680x1050 
1920x1200 

 

1280x720 
1360x768 
1600x900 
1920x1080 
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Example Examples 

 

1280x768 

 

1280x1024 

The output resolutions match the aspect ratios of incoming video when using these Small, Medium, and Large 
adaptive resolutions.  Not all resolutions can be adaptive. The following encodings must be formatted with specific 
aspect ratios: iPod and iPhone output, Windows Portable Media output, and the YouTube output.    For the adaptive 
ratios the following resolutions are used. 

Recorded Aspect Ratio Encoding Type Output Size 

4x3 Small 640x480 

Medium 800x600 

Large 1024x768 

16x10 Small 640x400 

Medium 800x500 

Large 1024x640 

15x9 Small 640x384 

Medium 800x480 

Large 1024x616 

5x4 Small 640x512 

Medium 800x640 

Large 1024x820 
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Search in Flash and Silverlight Encodings 
In the Flash and Silverlight encodings, the players include a Table of Contents based from slide titles and a Search 
field. 

The table of contents is available when the presentation is recorded from a PowerPoint or Keynote slide show. 

Viewers can enter search terms that check through the following:  

 Presentation audio 
If the profile used to process the recording was enabled to use the Transcribe presentation audio for full audio 
search option, a full transcription of the presentation audio is included in the searchable text.  

 Text 
The presentation must be playing (in slide show mode) in order for slide content to be captured. The following text 
is captured from a slide show:  

 Keynote ‘08 and ‗09  

 Slide title  

 Slide body which includes text such as in paragraphs, text boxes, and bulleted lists.  

 Presenter notes  

 PowerPoint 2004 and 2008 (Mac)  

 Slide title  

 Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art, and table data.  

 SmartArt shapes and chart data are not captured.  

 Alternate text for images is not captured.  

 Presenter notes  

 There is a known issue in PowerPoint 2004 (Mac) in that Camtasia Relay Recorder can only capture the first 255 
characters of each shape on a slide  

 PowerPoint 2003, 2007, and 2010 (Windows)  

 Slide title  

 Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art, table data, and 
alternate text for images.  

 Some SmartArt and chart data can be captured (2007 and later only).  

 Text which is not visible on the screen is not captured.  

 Presenter notes 

In general, skipped or hidden slides are not captured. 

The Camtasia Relay XML File 
Camtasia Relay provides XML files with the encodings for published presentations. The XML data contains 
information about the encoding such as the title, length, format, resolution, and more. 

Uses 

Customers may use the XML file with existing media-hosting solutions, content delivery methods such as RSS 
feeders, etc. TechSmith provides the XML data as a service, but does not support how the institution uses the XML 
file. 
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Information Included in the XML File 
 Presentation information: title, description, date, duration, and resolution 

 Profile used to create presentation 

 Presenter name 

 Client (computer used to make the recording) IP address, and computer name 

 Server name where recording was processed 

 Encoding preset used 

 Length of time the presentation was in the queue for processing 

 Length of time it took to encode the presentation 

 Destination URL of published presentation 

 Total duration of the presentation before trimming in milliseconds 

 Duration of the presentation after trimming was applied in milliseconds. 

 Time of the start trim point in milliseconds. 

 Time of the end trim point in milliseconds. 

 The time in milliseconds and text of the table of contents entries. 

 The time in milliseconds and text of the body text of all slides captured. 

 The time in milliseconds, duration in milliseconds, probability, and word for all the generated speech to text for full 
audio search. 

 Transcribed presentation audio or captions 
If the profile used to process the recording was enabled to use transcription option, a transcription of the 
presentation audio or the captions are included. 

 Slide show text 
The presentation must be playing (in slide show mode) in order for slide content to be captured. The following text 
is captured from a slide show: 

 Keynote ‘08 and ‗09 

 Slide title 

 Slide body which includes text such as in paragraphs, text boxes, and bulleted lists. 

 Presenter notes 

 PowerPoint 2004 and 2008 (Mac) 

 Slide title 

 Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art, and table data. 

 SmartArt shapes and chart data are not captured. 

 Alternate text for images is not captured. 

 Presenter notes 

 There is a known issue in PowerPoint 2004 (Mac) in that Camtasia Relay Recorder can only capture the first 
255 characters of each shape on a slide. 

 PowerPoint 2003, 2007, and 2010 (Windows) 

 Slide title 

 Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art, table data, and 
alternate text for images. 

 Some SmartArt and chart data can be captured (2007 and later only). 

 Text which is not visible on the screen is not captured. 

 Presenter notes 

In general, skipped or hidden slides are not captured. 
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Considerations 
 Deprecated Items 

 The duration element of the sourceRecording element is deprecated and will be removed in a future 

release. 

 The duration element of the encodeFiles element is deprecated and will be removed in a future release. 

 The duration element of the outputFiles element is deprecated and will be removed in a future release. 

 XML data is available for all encode types and all supported publish destinations with the following exceptions: 

 XML is not included with presentations published to iTunes U. 

 XML data is parsed into fields (as opposed to a single XML file) for presentations published to 
Screencast.com. The metadata can be found under the Details section when viewing a presentation on 
Screencast.com. 

 Certain elements of the XML data are optional depending on the recording and the profile configuration. 

 For instance, if PowerPoint or KeyNote presentations were not captured at record time, then there will be no 
table of contents or screen text information. 

 Also, if the ―Transcribe presentation audio for full audio search‖ option is turned off, then the presentation 
audio transcription will not be present in the metadata. 

 Flash and Silverlight encodings produce an XML file as well that will end with the text ―_xmp.xml‖ that should 
not be confused with the metadata .xml file. 

 Example Metadata XML File 

The following is an example XML file. 

<?xml version="1.0" encoding="utf-8"?> 

<presentation relayVersion="2.0.0"> 

 <title>Sea Turtles</title> 

 <description>A very interesting and engaging presentation on sea turtles.</description> 

 <date>6/28/2010 3:31:05 PM</date> 

 <profile>Biology 101</profile> 

 <destinationUrl>media.university.edu\bio101\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM.swf</destinationUrl> 

 <totalDuration>60600</totalDuration> 

 <trimmedDuration>60600</trimmedDuration> 

 <startTrimTime>0</startTrimTime> 

 <endTrimTime>60600</endTrimTime> 

<recordedBy> 

 <displayName>Jane Doe</displayName> 

 <email>j.doe@techsmith.com</email> 

</recordedBy> 

 <presenter> 

  <displayName>Jane Doe</displayName> 

  <userName>j.doe</userName> 

  <email>j.doe@techsmith.com</email> 

 </presenter> 

 <clientInfo> 

  <clientIP>192.168.0.1</clientIP> 

  <clientComputerName>desktop101.techsmith.com</clientComputerName> 

  </clientInfo> 

 <serverInfo> 

  <serverHostname>https://relayserver.techsmith.com/relay/rest.ashx</serverHostname> 

  <encodingPreset>Flash (Medium)</encodingPreset> 

  <timeToEncode>46157</timeToEncode> 

  <timeInQueue>500</timeInQueue> 

 </serverInfo> 

 <sourceRecording> 

  <resolution>1600x1200</resolution> 

  <!--duration is deprecated and will be removed in a future release.--> 

  <duration>60</duration> 

  <fileList> 
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   <file clientPath="C:\Users\j.doe\AppData\Local\TechSmith\Camtasia 

Relay\Recordings\REC_197d189.avi" serverPath="E:\Media\450\SourceFiles\8725.avi" 

size="22392320" sequence="0" type="ScreenRecordingFile" duration="60600" /> 

   <file clientPath="C:\Users\j.doe\AppData\Local\TechSmith\Camtasia 

Relay\Recordings\PPT_197d13b.xml" serverPath="E:\Media\450\SourceFiles\8726.xml" 

size="1536" sequence="0" type="TableOfContentsFile" duration="0" /> 

  </fileList> 

 </sourceRecording> 

 <encodeFiles> 

  <!--duration is deprecated and will be removed in a future release.--> 

  <duration>60</duration> 

  <fileList> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.mp4" 

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM.mp4" size="1830977" resolution="800x600" duration="60600" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.html" 

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM.html" size="10017" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_xmp.xml" 

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM_xmp.xml" size="46954" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumb.jpg" 

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM_thumb.jpg" size="64358" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumbnails.jpg" 

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM_thumbnails.jpg" size="14404" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.swf" 

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM.swf" size="457576" resolution="-1x-1" duration="60600" /> 

  </fileList> 

 </encodeFiles> 

 <outputFiles> 

  <!--duration is deprecated and will be removed in a future release.--> 

  <duration>60</duration> 

  <fileList> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.mp4" destinationPath=" 

media.university.edu\bio101\Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.mp4" 

size="1830977" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.html" 

destinationPath="http:// media.university.edu\bio101/Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM.html" size="10017" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_xmp.xml" destinationPath=" 

media.university.edu\bio101\Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_xmp.xml" 

size="46954" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumb.jpg" destinationPath=" 

media.university.edu\bio101\Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumb.jpg" 

size="64358" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumbnails.jpg" 

destinationPath="media.university.edu\bio101\Sea_Turtles_-_Flash_(Medium)_-

_20100628_03.32.49PM_thumbnails.jpg" size="14404" /> 

   <file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.swf" destinationPath=" 

media.university.edu\bio101\Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.swf" 

size="457576" /> 

  </fileList> 

 </outputFiles> 

 <metaData type="TableOfContents"> 

  <item startTime="300" text="Sea Turtles" /> 

  <item startTime="16900" text="Green Sea Turtles" /> 

  <item startTime="33900" text="Sea Turtles" /> 

  <item startTime="39800" text="Long living" /> 

  <item startTime="44600" text="Turtles in the wild" /> 

 </metaData> 

 <metaData type="ScreenText"> 

  <item startTime="300" text="Sea Turtles  Green sea turtles are reptiles whose ancestors 

evolved on land and returned to the sea to live about 150 million years ago." /> 

  <item startTime="16900" text="Green Sea Turtles  Green sea turtles are reptiles whose 

ancestors evolved on land and returned to the sea to live about 150 million years ago." /> 
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  <item startTime="33900" text="Sea Turtles   Found in warm seas worldwide" /> 

  <item startTime="39800" text="Long living.  Green sea turtles Are reptiles whose ancestors 

evolved on land and  Returned to the sea to  Live about 150 million years ago." /> 

  <item startTime="44600" text="Turtles in the wild.  Breeding Grounds Food Supply Protected 

Areas" /> 

 </metaData> 

 <metaData type="Speech"> 

  <!— 

   Additional items removed for brevity 

  --> 

  <item startTime="12390" duration="370" probability="0.491" text="sea" /> 

  <item startTime="12760" duration="460" probability="0.617" text="turtles" /> 

   <item startTime="13220" duration="60" probability="0.223" text="are" /> 

  <item startTime="13280" duration="470" probability="0.548" text="beautiful" /> 

  <item startTime="13750" duration="720" probability="0.469" text="creatures" /> 

  <item startTime="14500" duration="140" probability="0.393" text="that" /> 

  <item startTime="14640" duration="70" probability="0.779" text="are" /> 

  <item startTime="14710" duration="390" probability="0.347" text="found" /> 

  <item startTime="15100" duration="170" probability="0.340" text="in" /> 

  <item startTime="15270" duration="270" probability="0.587" text="warm" /> 

  <item startTime="15540" duration="650" probability="0.699" text="seas" /> 

  <item startTime="16190" duration="1200" probability="0.572" text="." /> 

  <!— 

   Additional items removed for brevity 

  --> 

 </metaData> 

</presentation> 
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Publish Destinations 
Completed presentations should not be published (hosted) on the Camtasia Relay server. Instead, Camtasia Relay 
can publish presentations to many kinds of media servers including FTP servers, network drives (file system), 
YouTube, iTunes U, WebDAV, and TechSmith‘s media-hosting site, Screencast.com. 

 If the publish destination you would like to use is not available in the list of publish destinations, you may have to 
install the appropriate plug-in before you can use it. See Plug-Ins in the Administrator Website Help for more 
information. 

Camtasia Relay can publish presentations to one or more of the following locations. 

  File System (Network drives, etc) 

  FTP Server (FTP & sFTP) 

 Screencast.com (TechSmith‘s media-hosting service) 

 Original Recording (Backup), Camtasia Studio Recording, and all the Real Media encoding options will not be 
embedded on SC.com 

 WebDAV   

  Microsoft Windows SharePoint 

 YouTube 

  iTunes U (Camtasia Relay formats supported by iTunes U include MP4 and MP3) 

  Mediasite 

  Drupal 

General Considerations 

Camtasia Relay will attempt to create directories when using file system, FTP, sFTP, and WebDAV publish 
destinations. If you are receiving messages that you cannot create directories, make sure the user has permission to 
create them (this is essential if you are going to use variables in your paths). If you do not want users to have the 
ability to create folders, setup the folders ahead of time and make sure the user has permission to create files within 
those directories. 

If you see Test Document.txt in your folders after setting up Relay, you can safely delete them. Relay will attempt to 
delete them, but if the user that‘s publishing doesn‘t have permission we will not be able to successfully clean up after 
the test. You can give the user in question permission to delete files to prevent these from sticking around in the 
future. 

 Currently, it‘s a known issue that you cannot use spaces in URL fields when setting up publishing destinations. 
Instead, use %20. 



Camtasia Relay   Technical Reference Guide 

www.techsmith.com  32 

FTP Servers 
Some things to keep in mind when using an FTP or sFTP publish destination: 

 Ensure the host is specified as a fully qualified domain name the host name is pingable. 

 We recommend that when setting up the FTP / sFTP publishing destination that you provide the host and only the 
host in the Host field. 
You should specify the folder structure within the Path field. The Path field requires \ to be used. This is 
intentional. When publishing, we use that as the separator and send change directory commands to the ftp / sftp 
server. This way we can support windows and unix based ftp servers. 

 There may be cases where a domain is needed depending on how the FTP / sFTP server is setup. If you are 
getting user permission or invalid user errors, try adding the domain. 

 Ensure the correct Protocol is selected (FTP vs sFTP). 

 Use an FTP client to log into the FTP server. Verify the specified Path is accessible and files can be created 
there. 

 The URL entry for file system publishing and FTP publishing attempts to map a URL to the destination where the 
media is published. If there are variables in the path, Camtasia Relay may not be able to verify that the mapping 
is correct. Make sure to use the Profile Test option to produce a test presentation to verify that the mapping works 
as expected. If there are no variables, Camtasia Relay attempts to publish and retrieve a test file to the 
destination path. If this is unsuccessful, the destination is marked as having an error. 
It is possible to completely override the destination level URL at the account level. 

File System 
Some things to keep in mind when using a file system publish destination: 

 File System Publish Destinations without a specified URL will limit content accessibility to only those users who 
have direct access to the file system. 

 A Publish Destination URL will allow users to access files on a limited access file system. Access will be 
controlled by the hosting web server. Depending on the way the file system is hosted, users may be able to see 
and access non-sequitor files (e.g., XML, thumbnails, etc.) in addition to the video files. An IIS Virtual Directory 
can provide URL based access to files in a file system. 

 Not all encodings will be directly viewable in a browser accessed from a file system URL. Camtasia Relay will 
generate HTML wrappers for Flash and Silverlight videos making them viewable on those user's computers 
having the respective players installed. The ability to view other files (mp4, swf, avi, rmvb, wmv, etc.) will depend 
on what viewers are available on each user's computer. 

 In many cases, a share needs to specified using a fully qualified domain name. For example, instead of using 
\\presentations, use \\presentations.yourOrganization.edu. 

 Verify the Path field is accessible using Windows Explorer on the server running the Relay Manager service. 
Copy and paste the Path from your browser into the address field of Windows Explorer and confirm the file share 
is accessible. Also confirm that files can be created in this location. This can be done simply by right-clicking in 
Windows Explorer and selecting to create a new document in the share location. 

 The URL should be verified by entering it into a browser. If it is an IIS Virtual Directory, check its configuration 
using IIS Manager. Ensure that Directory Browsing is enabled under the Features section. Side note: you will 
probably want to make the web.config file in this directory hidden so it is not seen in the directory browsed from 
the URL. 

 File system supports UNC paths to remote servers. 

 Variables used in paths should be as simple as possible. There is a hard limit of 260 characters for a file name 
and path. It‘s possible to easily overflow this limit by using variables like profile title or presentation title. It‘s also 
possible that using variables like profile title and presentation title can introduce characters that are not valid 
folder names. 

 If you are receiving messages that your user is unable to publish to a destination, please make sure to fill out the 
domain field. If there is not explicit domain, put the name of the machine that the destination points to. 

 The URL entry for file system publishing and ftp publishing will attempt to map a url to the destination where the 
media is being published. It‘s possible that we would be unable to verify that the mapping works if there are 
variables in the path. We recommend that you use the test profile portion of the profile creation pages in order to 

file://presentations
file://presentations.yourorganization.edu
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verify that you are able to map the urls correctly. If there are no variables, we will attempt to download the test file 
that we publish to the destination path. If we are unable to do so, we mark the destination as incorrect. 

 It is possible to completely override the destination level URL at the account level. 

NTFS File Permissions 

Camtasia Relay can send data to various file shares that exist on your network.  While we cannot give instructions on 
how to create file shares in every environment, we have included some links to information about creating and 
debugging a file share on Windows Servers. 

 How to Share Files and Folder over the Network in a Windows Server 2003 Domain Environment: 
http://support.microsoft.com/kb/324267 

 Shared Folders for Windows Server 2008: 
http://technet.microsoft.com/en-us/library/cc770406.aspx 

 Enable or Disable Sharing and Discovery: 
http://technet.microsoft.com/en-us/library/cc753176%28WS.10%29.aspx 

WebDAV 
With Camtasia Relay‘s WebDAV publishing protocol a variety of different publishing destinations are opened up for 
use with the system.  The following briefly describes some of the locations that can be used with WebDAV.  This is by 
no means an exhaustive list. 

Xythos 

http://www.xythos.com 

Xythos Software is a developer of content management software solutions for the enterprise and a subsidiary of 
Blackboard Inc. Xythos products include the WebFile content management platform and a family of applications for 
essential document and file management. Xythos' WebDAV-compliant solutions are licensed to commercial, 
education and government organizations around the world. 

Other WebDAV Publish Destinations 

The following location also contains a list of products that support WebDAV publishing: 
http://www.webdav.org/projects/ 

Considerations 

 If you have a problem, try the following: 

 Ping the WebDAV server (e.g., media.company.com) from the Relay server machine and confirm it is 
reachable. 

 Enter the WebDAV URL into a browser and confirm the WebDAV site can be accessed. 

 WebDAV is a protocol that is found in HTTP v1.1. We follow the standard for making directories and publishing 
files to WebDAV URLs. We do not manage any of the versioning or editing capabilities of the protocol as we are 
content creators at this time. 

 The Trust All Certificates option will tell WebDAV to accept any SSL certificate it receives from the destination. 
This is to help out those who are rolling this out in environments where they may be using self-signed certificates 
or trust that the destination server is a legit server. 

 Authentication types are as follows: 

 Basic – this is unencrypted. Use this if you aren‘t concerned about the username and password being sent in 
plain text. 

 Database – this is used primarily on Unix based setups of WebDAV. Apache has the ability to hook up its 
authentication to a database. If your setup uses that method of authentication, use this type. 

 Digest – this is more secure than Basic. 

 NTML – this is integrated windows authentication. This can be enabled in the IIS setup for a WebDAV 
destination 

http://support.microsoft.com/kb/324267
http://technet.microsoft.com/en-us/library/cc770406.aspx
http://technet.microsoft.com/en-us/library/cc753176(WS.10).aspx
http://www.xythos.com/
http://www.webdav.org/projects/
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 Microsoft SharePoint: You cannot use WebDAV to publish to SharePoint. Microsoft uses a specialized version of 
WebDAV that is not standard. In order to publish to SharePoint, please use Camtasia Relay‘s SharePoint 
publishing destination.  

 

YouTube 
Camtasia Relay can publish presentations directly to YouTube, but there are a few things to keep in mind when doing 
so. 

 Unverified YouTube accounts have a video length restriction. If the presentation from Camtasia Relay is longer 
than this limit, the video will be rejected by YouTube after upload. The Camtasia Relay server has no way to know 
if the presentation is accepted, as this step occurs after upload.  
For this reason, we suggest you also use the original backup encoding to create a backup of the presentation for 
profiles that use YouTube publish destinations. This way if the presentation video is rejected by YouTube after 
upload, there is another copy of the presentation and no data is lost. 

 For information on how to verify a YouTube account, see the YouTube website. As of November 2011, the 
process for verifying a YouTube account involves sending a text message to a mobile phone with a confirmation 
code.  

 YouTube often updates or upgrades their business processes, so the account limits and verification process may 
change. See the YouTube website for the latest information on account limits and verification. 

iTunes U Information 
Camtasia Relay can publish presentations directly to iTunes U provided the following conditions are satisfied: 

 Your institution has an iTunes U account. TechSmith is not affiliated with iTunes U. 

 The published presentations are encoded into a file type supported by iTunes U. Camtasia Relay offers: MP3 
Radio, MP3 Phone, IPod, and YouTube.. (iTunes U supports M4A, MP3, MP4, M4V, MOV, and PDF.) 

 You know the Shared Secret code provided to your school by Apple. This is a 32 character alpha-numeric code. 

 You have access to desired Media Group ID codes. These are 10-digit numbers that direct the produced media 
into a specific instructor‘s class. 

 Viewers need iTunes on their computers. 

 If you have a problem, try the following: 

 Double check the fields are entered correctly. 

 Ping the Site URL from the Relay server machine and confirm it is reachable. 

 Confirm the account is usable using the iTunes U desktop application. 

 The Relay server must be synced with a time server in order to ensure that the time does not get out of sync with 
what Apple expects. If the server is out of sync, you will get authentication errors as the signature of the request is 
invalid. 

What is my Media Group ID? 

1. Click on a class in iTunes U. 

2. Right click the Videos tab and select Copy iTunes Store URL. 
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3. Paste the URL into a document. It will look similar to: 
https://deimos.apple.com/WebObjects/Core.woa/BrowsePrivately/example.com. 
1927435401.01099125312 

4. The Group ID is the last 10 digits in the URL following the period 0: (1099125312). 

Screencast.com Information 
Screencast.com is the place to share your high-quality videos, documents, presentations, and images—simply and 
professionally. We never compress or alter your content...so what you upload is what viewers see. And with four 
levels of privacy controls, you get to decide who sees what. 

Screencast.com may occasionally scale large content to fit the viewer‘s browser window. In these cases, a button with 
appear above the content to allow the viewers to view such content in its original size. 

Benefits of publishing to Screencast.com 

 Presenters can easily manage, organize, and delete their presentations. 

 Presenters can attach additional materials to the video. For example, a viewer can download notes, the actual 
presentation slides, etc. This is not directly accessible from Camtasia Relay; presenters will have to log onto 
Screencast.com and use that interface to do this. 

 Screencast.com is hosted by TechSmith and is helpful for customers with limited bandwidth and media storage 
space. 

 Presenters can exercise individual control over how their content is protected. 

 Presenters can allow viewers to comment on their presentations. Please visit the following URL for more 
information: http://www.screencast.com/answers 

 Free Screencast.com accounts are available to everyone. Paid accounts may be purchased and offer extra 
benefits like extra storage space and monthly bandwidth, as well as custom templates. 

Considerations 

Every Camtasia Relay presenter (end user) needs a Screencast.com account. These accounts are not created via 
Camtasia Relay.  To obtain Screencast.com accounts, please visit 
http://www.screencast.com 

By default, presentations are stored in the Camtasia Relay folder on Screencast.com. Camtasia Relay Administrators 
can create multiple Screencast.com destinations for organizational purposes, and can also create multiple folders for 
Presenters. Presenters may also create their own folders on Screencast.com and assign them to their profile. 

The Camtasia Relay folder created on Screencast.com is marked as a hidden folder by default. This means that the 
content within can be shared via URL links by the presenter, but the contents of the folder are not publicly browsable 
on Screencast.com. It also contains a custom template to show it was created with Camtasia Relay. Presenters can 
use the Screencast.com website to change the viewing permissions on this folder if they like, or they can create their 
own tailored to their needs. 

Inform Presenters of Required Account Information 

Presentations will not be published until presenters sign in to the Camtasia Relay website and enter their account 
information. Ideally, introduce presenters to the Camtasia Relay website and have them enter their Screencast.com 
information before making recordings. 

Presenters that make a recording and upload a presentation before the information is entered receive an email with a 
hyperlink and instructions to solve the problem. The presenter must enter their Screencast.com account information 
on the Camtasia Relay website and then the presentation will be able to finish process via the website. 

http://www.screencast.com/answers
http://www.screencast.com/
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Server Troubleshooting 

Server Debugging 
The following are some tips for figuring out server issues. 

Publishing Failures 

Open the job status page and provide us with the error message reported. 

WebDAV 

If you get a 404 error from WebDAV after it‘s been working, this usually is indicative of the hard drive not having 
enough space left to accept the file. 

ITunes U 

Authentication errors are also sometimes the result of the server not having it‘s time updated by a central time server 
like time.microsoft.com. If it was working and it‘s not now, then that is usually the case. 

The other instance that is pretty common is when you have used the Course Id instead of the Media Group Id for 
publishing. 

Camtasia Relay Server Event Viewer 
Your server‘s Event Viewer can potentially provide a rich source of information regarding what‘s happening on the 
server when problems occur. 

Once the Manager Service starts on a server, it creates a TechSmith node in the Event Viewer which captures 
important information about when services start and stop.  It also captures error information when errors occur.  The 
events in the TechSmith event log are of use when contacting Technical Support. 

How to Export Event Viewer Logs 
The following information explains how to export the event viewer logs for the components of Camtasia Relay. For 
information on how to share these with TechSmith Technical Support, please see TechSmith Tech Support on page 
101. 

 If the TechSmith node is not present on a server where Camtasia Relay Server has been installed, this means 
that the Relay Manager Service never started on that server.  If the server isn‘t running and you there isn‘t a 
TechSmith node in the Event Viewer, try the Restart Camtasia Relay Server shortcut on the desktop, it may solve 
the problem. 
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Camtasia Relay Recorder 

Windows XP 

1. Go to Start > Run > eventvwr. 

2. Right-click TechSmith and select Save Log Files As. 

3. Save the log in the EVT format. 

4. Right-click Application and select Save Log Files As. 

5. Save the log in the EVT format. 

6. Right-click System and select Save Log Files As. 

7. Save the log in the EVT format. 

Windows 7 and Windows Vista 

1. Open the Start menu and in the search box, type ―event viewer‖ and press Enter. 

2. When the Event Viewer opens, expand Applications and Services Logs. 

3. Right-click TechSmith and select Save Events As. 

4. Save the log in the EVTX format. 

5. Expand Windows Logs. 

6. Right-click Application and select Save Events As. 

7. Save the log in the EVTX format. 

8. Expand Windows Logs. 

9. Right-click System and select Save Events As. 

10. Save the log in the EVTX format. 

Mac OSX 

1. Open Finder and go to /Library/Logs/TechSmith/. 

2. Right-click Camtasia Relay and select CompressCamtasiaRelay to create a ZIP file of the log files on the desktop. 

Camtasia Relay Server 

Windows Server 2008 

1. Open the Start menu and in the search box, type ―event viewer‖ and press Enter. 

2. When the Event Viewer opens, expand Applications and Services Logs. 

3. Right-click TechSmith and select Save Events As. 

4. Save the log in the EVTX format. 

5. Expand Windows Logs. 

6. Right-click Application and select Save Events As. 

7. Save the log in the EVTX format. 

8. Expand Windows Logs. 

9. Right-click System and select Save Events As. 

10. Save the log in the EVTX format. 

Windows Server 2003 

1. Go to Start > Administrative Tools > Event Viewer. 

2. Right-click TechSmith and select Save Log Files As. 

3. Save the log in the EVT format. 

4. Right-click Application and select Save Log Files As. 
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5. Save the log in the EVT format. 

6. Right-click System and select Save Log Files As. 

7. Save the log in the EVT format. 

The Manager Debug Log 
The ManagerDebug.log files can be viewed to gain more knowledge as to what is occurring with the Manager Service 
on the Camtasia Relay server.  For these files to be written on the server a line in the following file must be 
uncommented: 

c:\Program Files\TechSmith\Relay Server\Manager\manager.log4net.config 

1. Remove the comments in the following line if any exist: 

<!--<appender-ref ref="DebugAppender"/>--> 

so that it looks like this: 

<appender-ref ref="DebugAppender"/> 

 The appender-ref element can be found near the bottom of the file in the root element. 

Inversely, you may comment out the previous line in the file if everything is behaving properly and you do not 
require these log files. 

2. Then restart the Manager service. 

3. You can then look for errors in the following file: 

C:\Program Files\TechSmith\Relay Server\Logs\ManagerDebug.log 

 The information in this file may be beneficial when working with TechSmith if certain errors occur on the 
server. 
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Camtasia Relay Recorder Details 
The following information deals with technical aspects of the Camtasia Relay recorder and the recording process. 

Recorder Installation Builds 

 The information in this topic involves changing configuration settings. This is something that should only be done 
when trying to remedy an existing problem. This process has the potential to cause problems with Camtasia 
Relay. 

Both the Mac and the PC recorders build on the server each t ime the server is init ial ized .  The reason for 
this build is that each recorder points to a Camtasia Relay server team.  In other words, a recorder cannot 
communicate with both a server from Organization A and Organization B at the same time.  It must know whether to 

choose Organization A or Organization B.  The file that gets set is the UploaderService.config file on the PC or 

the Uploader.plist file in the Camtasia Relay.app on the Mac. 

%PROGRAMFILES%\TechSmith\Camtasia Relay\Uploader\UploaderService.config 

Camtasia Relay.app/Contents/Resources/Uploader.plist 

On the PC the DefaultEndpoint and TeamId are the values that get modified while on the Mac the 

defaultServer and teamId get modified. 

PC Configuration 

<DefaultEndpoint>https://relayserver.techsmith.com/relay/rest.ashx</DefaultEndpoint> 

<TeamId>6f2fc485-7084-46bc-ae9f-9463d99b0587</TeamId> 

 

Mac Configuration 

<key>defaultServer</key> 

<string>relayserver.techsmith.com/relay/rest.ashx</string> 

<key>teamId</key> 

<string>6f2fc485-7084-46bc-ae9f-9463d99b0587</string> 

 

 If the name of the DNS entry for the server must change, each recorder must then be changed to reflect the new 
server.  This can be done by either having the presenters download and install the new recorder when the server 
is rebooted or by updating these files accordingly.  A recorder that cannot find the server to which it is designated 
will appear in offline mode. 

The Camtasia Relay server automatically assigns a TeamId while the EndpointURL is specified during install.  This 

information can be gathered from the Relay database server by running the following SQL statement: 

SELECT LOWER(edptUrl) as EndpointURL, confValue as TeamId 

FROM Relay.dbo.tblEndpoint 

  INNER JOIN Relay.dbo.tblConfig ON confName = 'TeamId' 

These are some sample results of the query when it is run against the Relay database instance. 
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 The TeamId is only necessary for Relay server communication for the Portable client recorder.  Portable client 

recorders cannot communicate with other recorders outside of their own team.  An invalid TeamId will not affect 

communication between uploaders and the server. 

Deploy the Recorder with a System Image 
When distributing the Camtasia Relay to a large network of Windows based machines, it is often desirable to include 
the Camtasia Relay recorder as part of a system image that is deployed to all of the machines in your network. 

When setting up the system image that will be deployed, there is an important step that must be done. During the 
install process of Camtasia Relay recorder, the installer will generate a unique ―ClientID‖ that is used by the Camtasia 
Relay website to manage different computers that have the recorder installed. 

If a single installation of the Camtasia Relay recorder is loaded on multiple machines, the website will report Client 
Machines inaccurately. 

If you want to include the Relay Recorder in a system image, it is recommended that you zero out the ClientId 
GUID.  This can be located in the Windows Registry at: 

HKEY_LOCAL_MACHINE\SOFTWARE\TechSmith\Camtasia Relay\ 

When the ClientId is set to all zeros and the Relay Uploader Service starts (during the boot process of Windows), the 
Relay Uploader Service will generate a new unique ClientId. Once the image is distributed, each machine will properly 
generate their GUID. 

Detailed Steps 

The following steps provide a good system image for the Camtasia Relay recorder: 

1. Install the Camtasia Relay recorder on to the system that the image will be taken from. 

2. Stop the ―Relay Uploader Service‖ from the ―Services‖ in Control Panel (UploaderService.exe). 

3. Change the value of the ClientId key to 

 00000000-0000-0000-0000-000000000000 

The key is located at: 

HKEY_LOCAL_MACHINE\SOFTWARE\TechSmith\Camtasia Relay\ 

4. Take an image of the system while the Relay Uploader Service is stopped and ClientId GUID is all zeros. 

 DO NOT reboot the machine after you change the ClientId key to all zeros before you take the image of the 
machine. If you do the Relay Uploader Service will start up and put in a non-zeroed GUID, thus invalidating 
the change to all zeros and giving you an image where all installs will look the same to the Camtasia Relay 
server. 
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Microsoft Windows Directories 
The following directories all use Windows Environment variables to establish the full path.  You can find what this path 
is mapped to on the local machine by going to a DOS prompt and by typing: 

c:\set VARIABLENAME 

 

 All of the examples in the following pages use Microsoft Vista‘s environment variables. 

To see all of the variables mapped on a particular machine open a DOS prompt and type: 

c:\set 

 

Environment Variables Used for the Camtasia Relay 
Recorder 
Windows 7, Windows Vista, and Windows XP 

%ALLUSERSPROFILE% 

%PROGRAMFILES% 

%TEMP% 

Windows 7, Windows Vista, and Windows XP 

%LOCALAPPDATA% 

Windows XP 

%USERPROFILE% 
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Camtasia Relay Service Directories 
The Camtasia Relay uploader service runs in the background periodically looking for XML files in the following 
directories: 

Windows 7, Windows Vista, and Windows XP 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\QueuedPresentations\ 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ProcessingPresentations\ 

Windows XP 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia Relay\QueuedPresentations\ 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia 

Relay\ProcessingPresentations\ 

Uploader Sleep Times 
While there are no errors, the uploader will sleep for 60 seconds between checking for jobs. If the uploader does 
detect an error when it wakes up, it will double the last sleep time before it wakes up with an upper limit of an hour. 
For example, once an error is detected, the uploader will sleep for 120 seconds, then 240, then 480, up to an hour as 
long as there are no communication errors. The uploader will refresh its server availability cache once per hour, as 
long as the client isn‘t running. The server availability caches are updated more frequently when the recorder is 
running. SSL errors cause the uploader to sleep for 30 minutes and block all server calls from the recorder during that 
time. 

Launching the Recorder and Logging In 
When the user first launches the recorder a connection to the server is attempted.  The recorder looks for the 
DefaultEndpoint listed in the file: 

%PROGRAMFILES%\TechSmith\Camtasia Relay\Uploader\UploaderService.config 

Example contents of the file are shown below. 

<UploaderService> 

    

<DefaultEndpoint>https://RELAYDEV02.TECHSMITH.COMservername.techsmith.com/relay/rest.ashx</DefaultEndpoint> 

     <TeamId>6390a2e2-1187-4287-aaf2-c239a06ada29</TeamId> 

     <NumberOfAttemptsPerChunk>5</NumberOfAttemptsPerChunk> 

     <DefaultChunkSize>8192</DefaultChunkSize> 

     <WorkerThreadWakeupInterval>20</WorkerThreadWakeupInterval> 

     <!-- 

         Logging level for communications: 

         0 = No logging 

         1 = Errors only 

         2 = Verbose (only turn on to debug problems) 

     --> 

 

     <LogLevel>2</LogLevel> 

</UploaderService> 

After reading the endpoint the recorder attempts to connect rest.ashx on the server over port 443 using HTTPS 
(HTTP over Secure Sockets Layer). 

If the connection to the server fails the recorder will indicate that it is in ―Offline Mode‖ by showing the Offline icon: 

 

When the user logs into the system in offline mode, the recorder will attempt to validate the user against cached 
information.  These XML files give users access to their profiles even when using the system offline.  This information 
exists as XML files which reside in the following folders: 

Windows Vista and Windows 7 

%LOCALAPPDATA%\TechSmith\Camtasia Relay\CachedRequests 



Camtasia Relay   Technical Reference Guide 

www.techsmith.com  43 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\CachedRequests 

Windows XP 

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia 

Relay\CachedRequests 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia Relay\CachedRequests 

An example of one of the files is shown below.  (All data is shown on one line.  Line wrapping is displayed below.) 

 

Files and Directories Used for Test Recordings 

While Recording 

When creating a test recording, both a WAV file and an AVI are created in a directory which has a random ID 
appended to the end of it: 

%TEMP%\RelayTest_RANDOMID\ 

Example: 

c:\Users\j.doe\AppData\Local\Temp\RelayTest_7a6f67 

The files are stored in this directory and also have a random ID appended to the end of them: 

%TEMP%\RelayTest_7a6f67\RelayTest__captureRANDOMID.avi 

%TEMP%\RelayTest_7a6f67\RelayTest__captureRANDOMID.wav 

Examples: 

c:\Users\j.doe\AppData\Local\Temp\RelayTest_7a6f67\RelayTest__capture7a6f86.wa

v 

c:\Users\j.doe\AppData\Local\Temp\RelayTest_7a6f67\RelayTest__capture7a6f86.av

i 

After Recording 

When the recording has completed, the audio and video are interleaved and the recording is moved to: 

Windows Vista and Windows 7 

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\TESTRANDOMID.avi 

Windows XP 

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia 

Relay\Recordings\TESTRANDOMID.avi 
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Example: 

c:\Users\j.doe\AppData\Local\TechSmith\Camtasia 

Relay\Recordings\TEST7a6f77.avi 

When the user clicks Close, the recording is deleted. 

Files and Directories Used for Recording a Presentation 

Default Locations 
When the user clicks Record both a WAV file and an AVI are created in a directory which has a random ID appended 
to the end of it: 

%TEMP%\Relay_RANDOMID\ 

Example: 

c:\Users\j.doe\AppData\Local\Temp\Relay_7d8612\ 

If PowerPoint is being recorded than an additional XML file is also created. 

Example: 

 

Example: 

c:\Users\j.doe\AppData\Local\Temp\Relay_7d8612\ 

The recording files are stored in this the recording directory and also have a random ID appended to the end of them: 

%TEMP%\Relay_9417f5\Relay__captureRANDOMID.wav 

%TEMP%\Relay_9417f5\Relay__captureRANDOMID.avi 

Windows Vista and Windows 7 

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\REC_RANDOMID.avi 

Windows XP 

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia 

Relay\Recordings\PPT__RANDOMID.avi 

Examples: 

c:\Users\j.doe\AppData\Local\Temp\Relay_9417f5\Relay__capture941824.wav 

c:\Users\j.doe\AppData\Local\Temp\Relay_9417f5\Relay__capture941824.avi 

C:\Users\j.doe\AppData\Local\TechSmith\Camtasia 

Relay\Recordings\PPT_941824.xml 
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After Recording 

When the recording has completed, the audio and video are interleaved and the recording is moved to the following 
directory.  If a PowerPoint XML file exists, it remains in this location: 

Windows Vista and Windows 7 

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\REC_RANDOMID.avi 

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\PPT_RANDOMID.avi 

  

Windows XP 

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia 

Relay\Recordings\ REC_RANDOMID.avi 

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia 

Relay\Recordings\PPT_RANDOMID.avi 

Example: 

c:\Users\j.doe\AppData\Local\TechSmith\Camtasia 

Relay\Recordings\REC_9417f5.avi 

c:\Users\j.doe\AppData\Local\TechSmith\Camtasia 

Relay\Recordings\PPT_9417f5.avi 

An XML file for processing the video is created and placed in the folder: 

Windows Vista and Windows 7 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\QueuedPresentations\ 

Windows XP 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia 

Relay\QueuedPresentations\ 

Example: 

c:\ProgramData\TechSmith\Camtasia Relay\QueuedPresentations\5_1225817404.xml 

(The _# is based on the time of the presentation.  Later presentations will have a higher number.) 

After the Camtasia Relay uploader service chooses and completely uploads all the files for a presentation to the 
server, the XML file is edited and is moved to the directory: 

Windows Vista and Windows 7 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ProcessingPresentations\ 

Windows XP 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia 

Relay\ProcessingPresentations\ 

Example: 

c:\ProgramData\TechSmith\Camtasia Relay\ProcessingPresentations\125.xml 
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An example of the file‘s contents is shown below: 
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File Deletion and Cleanup 

When the presentation is fully complete, that is that all encodings and publishings have completed, the next time the 
uploader service communicates with the server and polls the XML directory, if the presentation is deemed to be 
complete, the presentation and its associated XML are deleted from both: 

Windows Vista and Windows 7 

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\ 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ProcessingPresentations\ 

Windows XP 

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia 

Relay\Recordings\ 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia 

Relay\ProcessingPresentations\ 

Specify an Alternative Directory for Files Used to Record a 
Presentation 
Certain user account or computer configurations may interfere with the Camtasia Relay recorder for Windows 
operating systems reliably submitting recordings to the Camtasia Relay Server. This happens in the following cases: 

 Roaming profiles 

User accounts configured with roaming profiles may lose their recent recordings if they log out before the 
presentation has completed uploading to the server. This happens when roaming profiles remove the user‘s 

AppData folder (%LOCALAPPDATA\TechSmith\Camtasia Relay\%USERNAME%) before the recording files 

finish uploading. 

 Deep Freeze 

Computers that use Deep Freeze or similar products may erase or reset the user‘s AppData folder before the 
recording files finish uploading.  

To accommodate Camtasia Relay customers who use roaming profiles or products like Deep Freeze, the Camtasia 
Relay recorder for Windows provides the ability to specify an alternative directory for recording files. This alternative 
directory can be specified in the registry or in an XML file. 

For more information see Protection from Configuration Management Software (Deep Freeze).  

 If you specify an alternative directory, it must be on a local drive. Due to issues with permission levels on network 
folders, presentation files cannot upload to the Camtasia Relay server.  

The Camtasia Relay recorder first looks for an alternative directory in the registry. If a value is not found there, the 

XML file is checked. If a value is not there, the default directory (%LOCALAPPDATA\TechSmith\Camtasia Relay) 

is used. In addition, if the specified alternative directory cannot be written to by the user, the default directory is used.  

Specify in Registry 

The registry location for specifying the recording files location is based on the operating system: 

 32-bit operating system: 

[HKEY_LOCAL_MACHINE\SOFTWARE\TechSmith\Camtasia Relay] 

 64-bit operating system: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\TechSmith\Camtasia Relay]   

with ―String value‖ RecorderFilesDirectory. Example values for RecorderFilesDirectory: 

 %PROGRAMDATA%\TechSmith\Camtasia Relay\%USERNAME% 

 D:\Thaw\Camtasia Relay Recorder Files\%USERNAME% 
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Specify with XML File 

The XML file for specifying the Recorder files location is  
%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\RelayRecorder.xml 

In this file, set element recorderFilesDirectory to the desired directory.  

An example RelayRecorder.xml file might be: 

   <?xml version="1.0" encoding="UTF-8" ?> 

   <camtasiaRelay> 

      <recorderFilesDirectory> D:\Thaw\Camtasia Relay Recorder Files</recorderFilesDirectory> 

   </camtasiaRelay> 

 The following environment variables may be used when specifying the recorder files directory: 

 ALLUSERSPROFILE 

 LOCALAPPDATA 

 APPDATA 

 HOMEPATH 

 PROGRAMDATA 

 USERPROFILE 

 USERNAME 

These variables must be in all capital letters and surrounded by percent symbols. For 

example: %PROGRAMDATA%\TechSmith\Camtasia Relay\%USERNAME% 

Troubleshooting 

If the alternative directory is inaccessible by the Camtasia Relay uploader, an error message is placed in the event log 
notifying that a Camtasia Relay job file could not be read / saved.  

Common reasons why the directory is inaccessible to the Camtasia Relay uploader include: 

 The directory requires access permissions greater than Local System.  

 The directory is located on a network drive that requires domain permissions. Use of a network drive is not a 
supported location for presentation files. 

 The directory is misspelled or invalid. 
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Mac OS X Directories 

 If you remove any folders related to Camtasia Relay or if you alter the uploader.plist file, the next time you 

run Camtasia Relay, a presenter will be prompted to install missing components. 

Uploader Daemon 
The Camtasia Relay‘s uploader runs as a launch daemon. It is configured to wake when files are placed into the 
Queued and Processing directories in 

/Users/Shared/TechSmith/Camtasia Relay/ 

About the Daemon’s Configuration 

The daemon is configured to launch the RelayUploader executable found in 

/Library/Application Support/TechSmith/Camtasia Relay/. 

The daemon runs under the nobody user and group. 

Uploader Sleep Time 

The Mac uploader will sleep for 5 seconds by default. Like the PC uploader, it doubles its wakeup time each time an 
error is found, including SSL errors. It will sleep for up to 2 hours. Upload jobs are detected immediately. 

About the Files Found in 
/Library/Application Support/TechSmith/Camtasia Relay/Controllers 

 The Uploader.plist file is the uploader‘s primary configuration file. The most significant piece of information is 

the default server. 

 The controllers.plist is a cached list of all the servers found in a team. If the uploader cannot talk to the 

default server, it will choose one of the other servers from this list. 

 The uploadercache.db file is the uploader‘s cache of user data. The data is stored in a flat file relational 

database format. 

Data Files & Directories 
~/Library/Preferences/com.TechSmith.CamtasiaRelay.plist 

 Contains all of the application specific preferences. 

 ~/Library/Application Support/TechSmith/Camtasia Relay 

 Contains the disaster recovery data file and a cache of user login information. 

~/Library/Logs/TechSmith/Camtasia Relay 

 Contains all of the log files for Camtasia Relay. 

/Users/Shared/TechSmith/Camtasia Relay 

 Contains all of the data files generated by the recorder. Both the recorder and uploader utilize this directory. 

/Users/Shared/TechSmith/Camtasia Relay/Capturing 

Contains all data files for a presentation that is currently being recorded. 

/Users/Shared/TechSmith/Camtasia Relay/Queued 

Contains xml files describing presentations currently in queue to be uploaded to the server. 

/Users/Shared/TechSmith/Camtasia Relay/Processing 
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Contains xml files describing presentations that are currently being processed on the server. The uploader 
periodically checks with the server for the state of the presentations found in this directory. When the server 
reports that these presentations have been successfully processed, the uploader will delete the 
corresponding files from the system. 

/Users/Shared/TechSmith/Camtasia Relay/Recordings 

Contains all data files for recorded presentations. When a user hits submit, the uploader copies the data files 
from the capturing directory to this directory. 

/Users/Shared/TechSmith/Camtasia Relay/Saved 

A temporary directory where presentations from the portable recorder are copied. 

/Library/Logs/TechSmith/Camtasia Relay 

 Contains all of the logs from the Camtasia Relay uploader. Since the uploader runs as a daemon service, it 
places its logs in the system‘s log folder. 

/Library/Application Support/TechSmith/Camtasia Relay 

 Contains the uploader executable and configuration files for the uploader. 

/Library/LaunchDaemons/com.techsmith.camtasiarelay.uploader.plist 

 The configuration file that informs the operating system how to launch the uploader as a daemon. 

 /Library/Application Support/TechSmith/Camtasia/Plugins/CamtasiaRelay.tscshareplugin 

 Contains the plug-in used by Camtasia for Mac to share presentations to a Camtasia Relay server. 

Launching the Recorder and Logging In 
When the recorder launches, it attempts to establish a connection to the server. If a connection could not be 
established, the recorder goes into an offline mode. While in offline mode the recorder will validate authentication 
requests against cached data stores. If the recorder can establish communication with the uploader daemon, the 
uploader daemon will use its cache. If the recorder cannot establish communication with the uploader daemon, it has 
its own cache found in 

~/Library/Application Support/TechSmith/Camtasia Relay. 

Recording 

While Recording 

While a presentation is being recorded, files will be put in the following directories: 

 Capturing Directory 

/Users/Shared/TechSmith/Camtasia Relay/Capturing/ 

 *.mov 

The movie files are the recordings generated by Camtasia Relay. 

 *.tscbif 

These are binary files that allow disaster recovery to heal the movie files if they are corrupted. 

 *.xml 

The table of contents file for the presentation is stored as XML. This file also contains text captured from 
recorded slides. 

 Presentations Directory 

~/Library/Application Support/TechSmith/Camtasia Relay/Presentations/ 



Camtasia Relay   Technical Reference Guide 

www.techsmith.com  51 

 RecordingSession.plist 

This file stores meta-data for the presentation and the paths to all the files (.mov,. tscbif,.xml) that make up 
the presentation. Disaster recovery utilizes this file to help restore a presentation in the event that Camtasia 
Relay crashes. 

After Recording 

When a user submits a presentation, the uploader will create an xml file with details about the presentation to be 
uploaded in /Users/Shared/TechSmith/Camtasia Relay/Queued. It will also copy all of the data files found in 
/Users/Shared/TechSmith/Camtasia Relay/Capturing to /Users/Shared/TechSmith/Camtasia Relay/Recordings. 

Once the recorder is informed that the uploader has successfully created its job file and copied all of the data files, it 
will delete the data files found in /Users/Shared/TechSmith/Camtasia Relay/Capturing and clear the 
RecordingSession.plist file. 

Once the uploader successfully uploads a presentation to the server, it will move the job file from the Queued 
directory to the Processing directory which is also found in 

 /Users/Shared/TechSmith/Camtasia Relay/  

Once the uploader receives confirmation from the server that the presentation has been successfully processed, it will 
delete the job file and the corresponding data files from the Recordings directory. 

Share Plug-in 

The Camtasia Relay share plug-in is used by Camtasia for Mac to share presentations to a Camtasia Relay server. 
When the recorder is installed, the plug-in is placed in /Library/Application Support/TechSmith/Camtasia/Plugins/ 
regardless of whether Camtasia for Mac is installed. 

When a user shares a presentation to Camtasia Relay from Camtasia for Mac, the presentation files are copied to 

/Users/Shared/TechSmith/Camtasia Relay/Capturing/ 

The share plug-in then notifies the uploader to upload the presentation. The uploader follows the same steps 
mentioned in "After Recording" for uploading a Camtasia:mac recording to a Camtasia Relay server. 

Uninstall Camtasia Relay 
1. Delete Camtasia Relay.app 

2. Uninstall the uploader daemon. 

a. Open Terminal. (/Applications/Utilities/Terminal.app) 

b. Execute the following commands 

sudo launchctl unload /Library/LaunchDaemons 

com.techsmith.camtasiarelay.uploader.plist 

sudo rm /Library/LaunchDaemons com.techsmith.camtasiarelay.uploader.plist 

3. Delete all files and folders mentioned in the Data Files & Folders section. The file  

Library/LaunchDaemons com.techsmith.camtasiarelay.uploader.plist was already deleted in 

step 2. 
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Change the Server to Which the Recorder Connects 

On the PC Client 
1. Go to: Control Panel > Administrative Tools > Services. 
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2. Find the Relay Uploader Service. Right-click and select Stop. 

 

3. Open the following file in a text editor as an administrator : 

C:\Program Files\TechSmith\Camtasia Relay\Uploader\UploaderService.config 

4. Edit the element content of the DefaultEndpoint element to point to a different server. 

<UploaderService> 

    <DefaultEndpoint>https://relayserver.techsmith.com/relay/rest.ashx</DefaultEndpoint> 

     <TeamId>6f2fc485-7084-46ba-ae9f-9465e99b0587</TeamId> 

     <NumberOfAttemptsPerChunk>5</NumberOfAttemptsPerChunk> 

     <DefaultChunkSize>8192</DefaultChunkSize> 

</UploaderService> 

5. Delete the EndpointList section of the code to remove all the old server data. 

<UploaderService> 

   <DefaultEndpoint>https://relayserver.techsmith.com/relay/rest.ashx</DefaultEndpoint> 

     <TeamId>6f2fc485-7084-46ba-ae9f-9465e99b0587</TeamId> 

     <NumberOfAttemptsPerChunk>5</NumberOfAttemptsPerChunk> 

     <DefaultChunkSize>8192</DefaultChunkSize> 

     <WorkerThreadWakeupInterval>20</WorkerThreadWakeupInterval> 

    <!-- 

        Logging level for communications: 

        0 = No logging 

        1 = Errors only 

        2 = Verbose (only turn on to debug problems) 

    --> 

     <LogLevel>2</LogLevel> 

     <EndpointList> 

          <Endpoint>https://relayserver.techsmith.com/relay/rest.ashx</Endpoint> 

     </EndpointList> 

</UploaderService> 

6. Save the file. 
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7. Right-click the Relay Uploader Service and by select Start to restart the Uploader service. 

 

8. Start the Camtasia Relay recorder.  You should now be connected to a different server. 

On the Mac Client 
1. We highly recommend deleting all files and folders associated with Camtasia Relay except the application itself 

and the preferences plist. 

2. Right click the Camtasia Relay application and click Show Package Contents. 

3. Navigate to: Contents > Resources. 

4. Open the uploader.plist file. 

5. Change the value of the defaultServer to the url that you wish to connect to. Make sure the url ends in 

relay/rest.ashx. 

6. Save the file. 

7. Launch Camtasia Relay. 

8. Follow the prompts for the automatic install. 
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Recorder Debugging 
To expedite the handling of a recorder issue, you can help the TechSmith team by submitting pertinent information 
with your support request. 

The following sections outline and explain the information that you can provide to TechSmith. 

Failed Upload 
If an upload fails from the recording machine it will be important to get to that recording machine to check its 
settings.  The communication from the recording machine to the server is one-directional, that is to say, the recording 
machine can communicate with the Camtasia Relay server via the uploader service/daemon, but the Camtasia Relay 
server cannot and does not initiate communication back to the recording machine.  In that way, it is necessary to go to 
the recording machine to investigate any problems with uploads. 

1. When you load the Camtasia Relay Recorder, can it find its connection to the server?  Does a green checkmark 
show to indicate that it is connected? 

a. If no, to which server address is it attempting to connect?  This can be found by hovering over the icon or by 
looking at either of the two files: 

 PC – Look at the content of the ―DefaultEndpoint‖ element. 
(For more information about this functionality please refer to Launching the Recorder and Logging In on 
page 42. 

  

%PROGRAMFILES%\TechSmith\Camtasia Relay\Uploader\UploaderService.config 

<DefaultEndpoint>https://server.domain.com/relay/rest.ashx</DefaultEndpoint> 

 Mac – Look at the ―defaultServer‖ key in a plist editor. 
(For more information about this functionality please refer to See "Launching the Recorder and Logging 
In" on page 50. 

/Library/Application Support/TechSmith/Camtasia Relay/Controller/Uploader.plist 

b. Is the server‘s fully qualified domain name absolutely correct? 

 If no, refer to section Change the Server to Which the Recorder Connects on page 52 to change the 
server. 

 If yes, continue with the questions in step 2 below. 

2. Do the clients respect SSL Certificate errors?  Is it possible that something is wrong with the certificate on the 
server? 

The following two locations on the client show this setting. 

 PC - Refer to the UploaderService.config file referenced above.  Look at the content of the 
―IgnoreSslCertificateErrors‖ element.  If it reads ―False‖ then any problem with the certificate can cause 
problems with the communication. 

 Mac – Refer to the Uploader.plist file referenced above.  Look at the ―IgnoreSslCertificateErrors‖ key.  If it 
reads ―No‖ or ―False‖ then any problem with the certificate can cause problems with the communication. 

To investigate problems with SSL please refer to the Camtasia Relay Server Security Administrator Guide. To find 
our how to obtain this document, seeAppendix A: Additional Help and Related Documentation on page 104.  

3. Is the uploader running? 

 PC – Open ―Administrative Tools‖, ―Services‖ and check to see if the ―Relay Uploader Service‖ is running.  If it 
is not, start it.  If it crashes for any reason send the following items to TechSmith Support. 

 Windows 7 & Windows Vista 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ 

 Windows XP 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia Relay\ 

4. If you continue to experience issues with uploading presentations on the PC, open the UploaderService.config file 
mentioned above and change the LogLevel to "2", which causes the Uploader to be more verbose in its logging.  
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5. After making this change, go to the Services window and restart the "Relay Uploader Service".  

Once the service is restarted, the verbose logs will be visible through Event Viewer under the Applications and 
Services Logs > TechSmith node.  

This should help our technical support team in debugging your issue. 

Add-In for PowerPoint Issues 
If you have issues with the Camtasia Relay PowerPoint Add-In, go through the following questions to try to isolate the 
issue. 

Initial Questions 

1. Is the Camtasia Relay Recorder working even if PowerPoint Add-in is not? 

2. How many audio input devices do you have on the box where the PowerPoint Add-in is not working? 

3. Have you tried installing the recorder on a computer that does not have any other PowerPoint Add-ins? 

Further Debugging and Checks 

 The following information about the Camtasia Relay PowerPoint Add-in applies to Camtasia Relay on Windows 
XP or, Windows Vista, and Windows 7 running PowerPoint 2003 or 2007. The PowerPoint Add-in does not install 
on 64-bit versions of Microsoft Office. 

Usually, PowerPoint Add-In issues are due to conflicts between multiple PowerPoint Add-ins.  Please attempt to 
provide answers to these questions to help TechSmith Support to look at the issue further: 

1. The version of Windows being used. 

In Windows, hit ―Start‖, ―Run‖, type ―winver‖ and hit ―OK‖. 

2. The version of PowerPoint being used. 

3. Steps to reproduce the problem. 

4. How many displays (monitors) are being used. 

5. Does Recorder still work? 

6. What other PowerPoint Add-ins are installed. 

 To see the installed Add-ins with PowerPoint 2010: 

i. Click the  Options button under the File tab. 

ii. Click the Add-ins choice in the left pane of the Options window. 

 To see the installed Add-Ins with PowerPoint 2007: 

i. Click the PowerPoint Options button under the round Office button. 

ii. Click the Add-ins choice in the left pane of the Options window. 

 To see the installed Add-Ins with PowerPoint 2003: 

i. Select the Add-ins choice under the Tools menu. 

ii. Also note any toolbars that may constitute an Add-In. 

Disabling the Camtasia Relay PowerPoint Add-In 

Often, PowerPoint will automatically ask you want to disable the offending add-in. You can accept this as a temporary 
work around. Below are additional options. 

If PowerPoint has multiple add-ins installed, you can try disabling the ones currently not needed. Instructions for 
disabling/enabling add-ins are as follows: 

PowerPoint 2010: 

1. Click the Options button under the File tab. 

2. Click the Add-Ins choice in the left pane of the Options window. 

3. Click the Camtasia Relay Add-in line and click the Go button. 
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4. Check or uncheck the box next to Camtasia Relay Add-in to enable or disable the Add-In, and click OK. 

 Additional information about how to enable and disable add-ins is available here: 
http://office.microsoft.com/en-us/powerpoint-help/HA010354315.aspx 

PowerPoint 2007: 

1. Click the PowerPoint Options button under the round Office button. 

2. Click the Add-Ins choice in the left pane of the Options window. 

3. Click the Camtasia Relay Add-in line and click the Go button. 

4. Check or uncheck the box next to Camtasia Relay Add-in to enable or disable the Add-In, and click OK. 

 Additional information about how to enable and disable add-ins is available here: 
http://office.microsoft.com/en-us/powerpoint/HA100341271033.aspx 

PowerPoint 2003: 

PowerPoint 2003 has no good way to disable the Camtasia Relay Add-in. Uninstall it instead – see the directions 
below. 

Uninstalling the Camtasia Relay Add-In 

If PowerPoint is crashing before you can use it to disable any add-ins, it will be necessary to uninstall the Camtasia 
Relay Add-in or other possibly conflicting Add-Ins. 

The Camtasia Relay PowerPoint Add-in can be uninstalled without uninstalling the Camtasia Relay recorder program.  

If PowerPoint has crashed, before proceeding, you may want to reboot your computer to be sure there are no hidden 
PowerPoint, Camtasia Relay recorder, or other processes in memory.  

1. Start uninstalling the Camtasia Relay PowerPoint Add-in by running the Camtasia Relay recorder installer.  

2. Select the Modify choice and click Next.  

3. On the following window, click the little button to the left of Microsoft Office PowerPoint Add-in and select the 
red X (Entire feature will be unavailable), and proceed with the un-installation. 

 It is also possible to initially install Camtasia Relay without the PowerPoint Add-in, if desired.  
Click the Options button on the initial installing window, disable Install the Camtasia Relay Add-in for 
Microsoft PowerPoint, and proceed with the installation. 

Files to Include With a Support Request 
Please include the following files when submitting a support request for the Camtasia Relay recorder. 

Windows Client 

Log Files 

Locate the ―UploaderService.log‖ file from the  
C:\Program Files (x86)\TechSmith\Camtasia Relay\Uploader. 

Please also send any relevant messages from the Windows Event log. 

To enable client logging on the PC, create a text file that matches the name of the application and place it in the same 
directory as the application. In most cases, this file will be named "RelayRecorder.log." Please create this file, 
reproduce the error, and send it to TechSmith. 

http://office.microsoft.com/en-us/powerpoint/HA100341271033.aspx
http://office.microsoft.com/en-us/powerpoint/HA100341271033.aspx
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Mac Client 

Crash Logs 

Crash Logs do the most to help TechSmith diagnose a problem should a crash occur.  Send any file with the word 
―Uploader‖ or "Relay" in its name that is in the following two directories: 

~/Library/Logs/CrashReporter/ 

/Library/Logs/CrashReporter/ 

Log Files 

Send any files from the following directories to TechSmith when reporting an issue: 

/Library/Logs/TechSmith/Camtasia Relay 

~/Library/Logs/TechSmith/Camtasia Relay 

Stalled Mac Recorder 

If you have a stalled Mac recorder: 

1. Open the Activity Monitor application from /Applications/Utilities. 

2. Choose the CamtasiaRelay process and select Sample Process from the View menu. 

3. Send this text to TechSmith. 

Clearing Jobs 

Delete the contents of the following folders: 

/Users/Shared/TechSmith/Camtasia Relay/Queued 

/Users/Shared/TechSmith/Camtasia Relay/Processing 

/Users/Shared/TechSmith/Camtasia Relay/Recordings 

Protection from Configuration Management Software 
(Deep Freeze) 
The use of configuration management software such as Faronics‘ Deep Freeze is possible with Windows and Mac 
Camtasia Relay recorders.  However, certain additional considerations are necessary for both the installation and 
regular use of the Relay client in order to ensure an optimal experience for users of the software. 

 The use of configuration management software such as Faronics‘ Deep Freeze on a Camtasia Relay Server is 
not recommended. 

Recorder Installation and Upgrade 

For the initial installation and periodic upgrades of the Camtasia Relay recorder, it is highly recommended that the full 
system be unfrozen to allow for successful installation of all required components. 

Daily Use 

For regular use of a frozen computer, system administrators that implement Deep Freeze or similar software on 
clients should carefully consider the configuration management application‘s handling of persistent data on disk. Deep 
Freeze allows the designation of disk locations as ―ThawSpace‖ in order to retain data across sessions when the 
computer is in a frozen state. 
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The following locations are used for storage of Camtasia Relay user data and should therefore be considered for 
designation as ThawSpace. 

 Windows (all versions) 

%TEMP% 

 This system path is only used by the Relay recorder to store data until the user chooses to submit or discard 
a presentation. 

 Windows Vista and Windows 7 

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ 

%LOCALAPPDATA%\TechSmith\Camtasia Relay\ 

 Windows XP 

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia Relay\ 

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia Relay\ 

 Leopard and Snow Leopard 

/Users/Shared/TechSmith/Camtasia Relay/ 

More information on Deep Freeze, including User Guides and FAQs, can be found at: 
http://www.faronics.com/support 

For more information, see Specify an Alternative Directory for Files Used to Record a Presentation. 

http://www.faronics.com/support
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Include Webcam Video in a Presentation 
Camtasia Relay provides powerful tools for recording, processing, and distributing presentations. It is important to 
keep in mind that Camtasia Relay records whatever is displayed on the screen of your PC or Mac. In some cases, 
you may be recording a demonstration of a piece of software, while in others you are recording a presentation made 
using Microsoft‘s PowerPoint. 

But what if you want to include video from a webcam in your presentation? You may, for example, want to show the 
face of a professor as they give a lecture or include a video of someone drawing on a whiteboard. 

Fortunately, there are a multiple ways to accomplish this, two of which we discuss in this document. The primary way 
is to select a camera in the recorder, which will include webcam video in a picture-in-picture (PiP) on the presentation 
video. Another way is to use Camtasia Relay in conjunction with Camtasia Studio; while yet another is to use the 
software that comes with a webcam to show (and then capture) the video right on your desktop. 

Record Webcam Video in Camtasia Relay Recorder 
The Camera button in the recorder opens a camera selection window. Select a camera based on the preview shown 
in the selection window. This process is very similar to selecting a display when multiple displays are available. 

 Camera video is only included in profiles that use the Adobe Flash or Microsoft Silverlight encodings. 

 Camtasia Relay supports record webcam video with presentations. It does not support digital video (DV) cameras 
at this time. 

For more information on selecting a camera to record with a presentation, see the Camtasia Relay recorder help. 

Record with Camtasia Studio 

 The following process involves using Camtasia Studio, which you can purchase from TechSmith and use in 
conjunction with Camtasia Relay. This integration allows for more robust recording and editing features, while still 
providing the ease of automatic processing and publishing with Camtasia Relay. 

The most flexible way to include a webcam video in your presentation is to record with Camtasia Studio and then 
produce and publish with Camtasia Relay. Because Camtasia Studio records the webcam video separately from the 
presentation, you can run PowerPoint as you normally do, without making any special size adjustments. In Camtasia 
Studio, you can also change the location of the webcam video in your presentation before sending it to Camtasia 
Relay for processing and publishing 

To record your presentation and webcam video with Camtasia Studio: 

1. Launch Camtasia Studio and click Record the Screen. 

2. When the recorder opens, select Full screen. 

 

http://www.techsmith.com/camtasia
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3. Click the Webcam button to enable webcam recording. 

 
A live preview of the webcam appears to the right of the Webcam option. 

4. Open PowerPoint and start your slideshow. 

5. Click the Record button. 

 

6. Record and edit your presentation with Camtasia Studio, including adjusting the location of the webcam video in 
your presentation. 
For more information about working with and options for including a webcam video, open the Camtasia Studio 
Help and go to Edit and Add Effects to Your Video > Video Effects > Picture-in-Picture (PIP). 

7. Produce and share the presentation to the Camtasia Relay server for final processing and publishing. 

 

8. Log in to Camtasia Relay, choose a profile, add a title and description for the presentation, and click Submit. 
The presentation uploads to the Camtasia Relay server and, when processing and publishing are complete, the 
presentation is published showing the presentation and the webcam video. 
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Record Video Playing on the Desktop 
With a small amount of setup and a little practice, you can record webcam video using Camtasia Relay and a 
webcam. This is a good method to try if you do not own Camtasia Studio. 

As an example, here is a link to a video made by Jane Maurer, Instructional Technologist from the University of 
Denver. In the video, she shows how a presenter can include a headshot of themselves, show students how to use a 
software product, present a Microsoft PowerPoint slide show, or even show a video clip while recording the video feed 
from a webcam. 

http://ctl.du.edu/relay/Camtasia%20Relay%20Sample%20-%20Web%20(640x480)%20-
%2020090520%2001.37.29PM.html 

For the following example, we are recording a Microsoft PowerPoint presentation while also including a video of a 
presenter at a whiteboard. 

Setup needed 
 Computer: PC or Mac. 

 A webcam: For our example, we used a Logitech 1.3 Megapixel webcam but most standard webcams work. 

 Webcam software: Software that shows the live image through your camera. For our example, we used the 
Logitech Quickcam for Enterprise software that came with our webcam, but you can use other software products 
as well. You do not actually need to record anything using the webcam software, but you do need it to control 
your camera. 

Setting up PowerPoint 
If you use Microsoft PowerPoint, a couple of steps during setup make it easier to create the kind of recording that you 
want. 

For this example, we used Microsoft PowerPoint 2007. With PowerPoint, when you run a slide show, by default, the 
slide show takes up the entire display. Since the entire display is used for the slide show, you cannot see your toolbar 
and may not have a way to start or select your webcam software. With the default settings, the video from your 
webcam does not appear on the display and is not recorded. 

To run your slide show in a smaller window: 

1. In PowerPoint, go to Slide Show > Set Up Slide Show. 

 

2. Change the Show type to Browsed by an individual (window). This runs your slide show in a window that does not 
take up the entire screen. 

http://ctl.du.edu/relay/Camtasia%20Relay%20Sample%20-%20Web%20(640x480)%20-%2020090520%2001.37.29PM.html
http://ctl.du.edu/relay/Camtasia%20Relay%20Sample%20-%20Web%20(640x480)%20-%2020090520%2001.37.29PM.html
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3. Start the software for your webcam. 

4. If possible, set the size of the window that you want for your video. With the Logitech Quickcam for Enterprise 
software that we used for our example, we chose 640 x 480. 
Note that your webcam software may not let you choose the size for your video. 

 

5. Move the webcam video next to your PowerPoint slide show. 

 

6. Once you have your webcam set up, do a few practice recordings to make sure that it is working the way you like. 
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Considerations 
 While including webcam video may be necessary for you, keep in mind that it makes your recording files much 

larger than they would be with just slides – perhaps as much as 10 times larger. This results in slower uploading 
and encoding, as well as using more room for file storage. 

 For Release 3.1 and later, Camtasia Relay records at a maximum of 15 frames per second (fps). This could make 
videos that contain a high amount of motion appear choppy. Do a test recording to make sure that the published 
presentation quality is acceptable for your needs. 

 If the quality does not meet your needs, recording with Camtasia Studio may be a better option for you. When 
recording with Camtasia Studio, you can define recording options such as the frames per second to record and 
other settings to allow for higher quality webcam video in your final presentation. 

 If your recording is played back on iPods or other handheld devices, make sure that the window for your video is 
large enough so that viewer can see enough detail. 

 There is no way to move or remove the webcam video after recording. 
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Camtasia Relay Portable Recorder 
Provide the portable recorder to presenters if there is any reason that presenters cannot (or should not) record and 
upload directly from the presentation computer. For example: 

 Presenters record on computers where they do not have permission to install applications. 

 Presenters record on computers that have limited or no network access. 

 You want to collect the presentations and upload them collectively at a later time. 

You can select how you want presenters to access the portable recorder on the System > System Options page. 

If you choose to have presenters contact an administrator to receive a portable recorder, you will want to install the 
Camtasia Relay portable recorder on a mobile storage device and distribute to presenters. Use the following process 
to install the portable recorder on a mobile storage device, such as a USB flash drive. 

1. Plug in a mobile storage device and format the device as FAT32. 

2. Click Download Portable Recorder and save the .zip file to your computer. 

3. Locate and open PortableCamtasiaRelay.zip. 

4. Copy all files from the .zip file onto the mobile storage device. 

 All files from the .zip need to be copied to the root of the device for the Camtasia Relay portable recorder to 
autorun on Microsoft Windows. (Autorun is not available for the Windows 7 or Mac operating systems.) 

Administrators can decide how they would like presenters to access the portable recorder. Choose from the following: 

Option Description 

Available by 
Download only 

The portable recorder is available on the website. Presenters can log in to the website and 
download the portable recorder and transfer it to a mobile storage device, such as a USB. 

You may want to use this option if you feel presenters are reasonably ―technical‖ and understand 
downloading and unzipping files.  

Available by 
Email Request 
only 

There is a button available on the website to request a portable recorder. Presenters can log in to 
the website and click this link to send an email request to the administrator. 

You may want to use this option if you feel presenters are very ―not technical‖ and may not 
understand downloading and unzipping files. The administrator will receive an email that the user 
requested a portable recorder. You can put the portable recorder on a mobile storage device and 
give it to the presenter. 

Not Available There is no way for a presenter to download or request a portable recorder. 

You may want to use this option if you will handle distributing all portable recorders. 

 Even if they do not have access to the portable recorder, presenters will still be able to 
find information about it in the Help and other locations. 
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Special Files on the Portable Recorder 

 In the following section ―PortableRoot:‖ refers to the drive letter that the Relay Portable Recorder is mapped to. 
―SystemRoot:‖ refers to the drive letter that the operating system is installed on. 

Files 
 PortableRoot:/Camtasia Relay/USBConfig.xml 

 Contains the Team ID – this is used to match a portable recorder to its parent Camtasia Relay server. 

 The Team ID allows the portable recorder to know that the Camtasia Relay Uploader is part of the same 
installation as the portable recorder. If the Team IDs do not match, then the Portable Recorder will remain 
offline. This is designed to protect a user from sending their presentation to the wrong Camtasia Relay server. 

 Example: 

<?xml version="1.0" encoding="utf-8"?> 

<usbconfig> 

 <teamid>24bca0cd-7c5d-4f8a-a854-db7838240c74</teamid> 

</usbconfig> 

 PortableRoot:/Camtasia Relay/ProfileCache.xml 

 This is the cached login file. It stores usernames and encoded passwords for offline authentication. 

 Example: 

<?xml version="1.0" encoding="UTF-8" ?> 

<relay Version="2.0.0"> 

 <rememberMe isGuest="0" email="s.smalls@example.com">Scotty Smalls</rememberMe> 

 <presenter name="s.smalls" fullName="Scotty Smalls" email="s.smalls@example.com" 

phash="91851d40087ca6720037dce68fb7d769a12a3784" authCode="d87c46ed-31a8-45a6-8a10-22e207374751"> 

  <profileList /> 

 </presenter> 

 <presenter name="b.rodriguez" fullName="Benjamin Franklin Rodriguez" 

email=”b.rodriguez@example.com" phash="e0c9035898dd52fc65c41454cec9c4d2611bfb37" 

authCode="e33101a8-f39e-4f64-8de0-462af7d83d48"> 

  <profileList> 

   <profile title="HIST 320: The African Diaspora" id="3" /> 

   <profile title="CSE 480: Computer Databases" id="4" /> 

  </profileList> 

 </presenter> 

</relay> 

 PortableRoot:/Camtasia Relay/Recordings/recordings.xml 

 Contains the info for the presentations located on the portable drive. 

 Example: 

<?xml version="1.0" encoding="UTF-8" ?> 

<relay Version="2.0.0"> 

 <presenter> 

  <presentations /> 

 </presenter> 

 <presenter username="" fullname="Hamilton Porter" email="" authCode=""> 

  <presentations> 

   <presentation> 

    <profileId>-1</profileId> 

    <title>Intro to World History</title> 

    <description>The Nile Delta</description> 

    <creationdate>2010-02-15 10:14:19 -0400</creationdate> 

    <duration>2200</duration> 

    <maxresolution>1600x1200</maxresolution> 

    <diagnostics></diagnostics> 

    <trimstart>0</trimstart> 

    <trimend>2200</trimend> 

    <files> 

     <file type="0" order="0" fileDuration="2200" fileWidth="1600" 

fileHeight="1200">rec_1ea74328.avi</file> 

     <file type="2" order="0" fileDuration="0" fileWidth="1600" 

fileHeight="1200">relaythumbnail1ea812e5.png</file> 
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    </files> 

   </presentation> 

  </presentations> 

 </presenter> 

</relay> 

 PortableRoot:/Camtasia Relay/Recordings 

Contains all of the data files for recorded presentations. 

 PortableRoot:/Camtasia Relay/Recordings/*.avi 

Stored video files created on a Windows operating system – see recordings.xml for attributes 

 PortableRoot:/Camtasia Relay/Recordings/*.mov 

Stored video files created on a Mac operating system  – see recordings.xml for attributes 

 PortableRoot:/Camtasia Relay/Recordings/*.png 

Thumbnail images for use with Saved Presentations dialog. 

How It Works 
The Camtasia Relay portable recorder is the same executable as the normal recorder. However, the recorder will 
operate in portable mode when it detects that it is running from a Plug and Play device. 

 When doing a recording, the portable recorder acts like the normal recorder until you are ready to complete your 
recording. It temporarily saves the data files to the temporary directory given below. If an uploader is not present, 
the recorder will copy the entire data file to the portable storage device. If an uploader is present, the portable 
recorder will give you the option to save the presentation or upload it. The process of uploading the presentation 
follows the workflow of the normal recorder. 

 Mac operating system 

 Temporary capturing directory:  
/Users/Shared/TechSmith/Camtasia Relay/Capturing 

 Saved presentation directory: 
/Users/Shared/TechSmith/Camtasia Relay/Saved 

 Windows operating system 

Temporary and saved presentation directory: 

 Windows 7 and Windows Vista: 
SystemRoot:\Users\%USERPROFILE%\AppData\Local\TechSmith\Camtasia 

Relay\Recordings 

 Windows XP: 
SystemRoot:\%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia 

Relay\Recordings 

 The Saved Presentation dialog shows all presentations that have been saved to the portable recorder. When a 
presentation is submitted from the Saved Presentations dialog, the files are copied from the portable storage 
device to saved presentation directory. Once the data is successfully moved to that directory, the upload process 
follows the normal recorder‘s upload workflow. 



Camtasia Relay   Technical Reference Guide 

www.techsmith.com  68 

The Recordings.xml File 
Meta data for all recordings saved to the portable storage device is found in the recordings.xml file. Presentations are 
grouped on a per presenter basis. If you wish to delete a presentation by hand, you must delete the corresponding 
presentation node found under the corresponding presenter. Also, remember to delete all associated files found in the 
Recordings directory. These files are listed in the files section of the presentation node. 

The Windows Portable Recorder 
The following information is specific for the portable recorder that runs on the Windows operating system. 

AutoPlay Capabilities on Microsoft Windows 
Depending on the security settings on the machine or via the Group Policy, the Camtasia Relay portable recorder may 
be able to automatically prompt the user to start the recorder when the portable recorder is connected to the machine. 

 These settings may be governed by Group Policy settings which can prevent the user from editing these options. 

 This functionality is not present on the Macintosh operating systems due to security concerns, and Microsoft has 
announced that it will no longer be available in the future on the Windows Operating Systems.  This functionality 
is not available on Windows 7, but is still possible in Windows XP and Windows Vista. 

Windows Vista 

To configure this option in Windows Vista please follow these steps: 

1. Open the Windows Control Panel 

2. Click Classic View option on the left. 

3. Click AutoPlay. 
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4. Depending on the type of media that you are using for the Portable Media Device, you can then set the default 
action when a media device of that type is inserted.  The ―Ask me every time‖ option will allow the selector screen 
to display. 

 

Troubleshooting options 

For troubleshooting options regarding Windows Auto-Play options please refer to the following URL: 
http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx 

Running on Windows Operating System with AutoPlay Enabled 
Under certain conditions, when you connect a mobile storage device that contains the portable recorder with a 
computer, you are presented with the option to immediately start the application. 

Click ―Start Camtasia Relay‖ to run the recorder. 

Windows Operating System with AutoPlay Disabled 
If AutoPlay is disabled, to run recorder: 

1. Open Windows Explorer (Right-click on Start and select Explore.) 

2. Navigate to the mobile storage device. 

3. Double-click PC Camtasia Relay.exe. 

The Mac Portable Recorder 
To run the portable recorder on a Mac: 

1. Navigate to the mobile storage device. 

2. Double-click Mac Camtasia Relay. 

The file is actually ―Mac Camtasia Relay.app‖, but, depending on their system settings, Mac users may see this 
file as ―Mac Camtasia Relay‖. 

 

http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx
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TechSmith Fuse for Camtasia Relay 
TechSmith Fuse is a camera video recorder designed for use with the Camtasia Relay server. TechSmith Fuse 
records camera video and uploads it to a Camtasia Relay server for automated encoding and publishing. TechSmith 
Fuse also can upload existing videos from your device to a Camtasia Relay server.  

TechSmith Fuse is available for download from the Apple App Store or by using this link: 
http://www.techsmith.com/redirect.asp?target=ios_fuse&ver=3.1.0&lang=enu&os=win&product=relay 

TechSmith Fuse requires a server running Camtasia Relay 3.1 or later and a device with iOS 4.0 or later. 

 

http://www.techsmith.com/redirect.asp?target=ios_fuse&ver=3.1.0&lang=enu&os=win&product=relay
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Camtasia Relay Database 
A major component of the Camtasia Relay architecture is the SQL Server (Express) database component that stores 
information about presentations, users, profiles, and other system settings. This section contains information about 
working with this database. 

Identifying the Camtasia Relay Databases 

The name of the database depends on the version of Camtasia Relay. 

Database Name Camtasia Relay Version 

RelayRuntime 1.0 

RelayMeta 1.0 

Relay 1.1 or 1.2 

Relay20 2.0 

Relay300 3.0.0 

Relay301 3.0.1 

Relay302 3.0.2 

Relay303 3.0.3 

Relay400 4.0.0 

Back Up the Camtasia Relay Database 

Considerations 

The Camtasia Relay database contains critical information regarding the configuration and operation of the server 
application.  It is highly recommended that the database be backed up on a regular basis and that restore operations 
are periodically tested to prevent the potential loss of data. 

Database backups may be performed manually or on a schedule.  Options exist for performing backups through SQL 
Server directly or with the use of third party backup applications.  Users of Camtasia Relay should select a backup 
regimen that best fits with their organization‘s disaster recovery policies, existing procedures, and tolerance for 
acceptable data loss. 

By default, the Camtasia Relay database runs in Simple Recovery model.  For a more fine-grained approach to 
backups and restoration of the database, use of the Full Recovery or Bulk-Logged Recovery model is feasible but 
should be thoroughly tested in your environment prior to implementation.  The use of one of these recovery models 
may adversely impact performance of the database and the consumption of server resources.  More information on 
SQL Server recovery models can be found at: 
http://technet.microsoft.com/en-us/library/ms189275.aspx 

General information regarding SQL Server backups can be found at: 
http://msdn.microsoft.com/en-us/library/ms175477.aspx 

http://technet.microsoft.com/en-us/library/ms189275.aspx
http://msdn.microsoft.com/en-us/library/ms175477.aspx
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Back Up Using SQL Server Management Studio 

The procedure for performing a full database backup with SQL Server Management Studio or SQL Server 
Management Studio Express is shown below and is essentially identical for both SQL Server 2005 and SQL Server 
2008 Express and Standard editions. 

This procedure can be performed locally on the database server or from a remote management workstation with SQL 
Server Management Studio installed if remote access to the database server has been allowed.  However, disk 
locations denoted in the backup procedure will always be local to the database server. 

1. Right click the database to back up and select Tasks > Back Up. 
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2. On the General tab, select backup type Full and set a location on disk for the backup file. 

 

3. Choose to backup to an existing backup set or to append to a new backup set.  Selecting Verify backup when 
completed is recommended.  Then, click OK. 

The backup is complete. 

  

 As a follow up to a successful backup, it is highly recommend that the local backup file be copied to a location that 
protects it from the loss or failure of the database server. 

More information on performing database backups via Management Studio may be found at: 
http://msdn.microsoft.com/en-us/library/ms189621.aspx 

Official Instructions regarding How to Backup a Database using SQL Server Management Studio can be found at: 
http://msdn.microsoft.com/en-us/library/ms187510%28SQL.90%29.aspx 

http://msdn.microsoft.com/en-us/library/ms189621.aspx
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Back Up Using a SQL Script 
Backups of SQL Server databases can be scripted for use in a SQL batch file, freehand execution via SQL Query 
Editor or sqlcmd, or use in an external application. 

The following example script performs a full database backup of the Relay300 with the same options listed in the 
previous section Back Up Using SQL Server Management Studio on page 72. 

USE Relay300; 

GO 

BACKUP DATABASE Relay300 

 TO DISK = 'C:\Program Files\Microsoft SQL 

Server\MSSQL10_50.RELAY\MSSQL\Backup\Relay300.bak' 

 WITH NOINIT, 

 NAME = 'Relay300-Full Database Backup', 

 RETAINDAYS = 0, 

 STOP_ON_ERROR; 

GO 

RESTORE VERIFYONLY 

 FROM DISK = 'C:\Program Files\Microsoft SQL 

Server\MSSQL10_50.RELAY\MSSQL\Backup\Relay300.bak' 

GO 

A simpler one-time backup that does not append to an existing media set or use extra verification can be performed 
with the following.  This script will overwrite any existing backups in the backup file specified 

USE Relay300; 

GO 

BACKUP DATABASE Relay300 

 TO DISK = 'C:\Program Files\Microsoft SQL 

Server\MSSQL10_50.RELAY\MSSQL\Backup\Relay300.bak' 

 WITH FORMAT; 

GO 

More information on the BACKUP command can be found at: 
http://msdn.microsoft.com/en-us/library/ms186865.aspx 

Back Up Using the Command Line 
SQL Server‘s sqlcmd command line utility can be used to perform any task that is possible with SQL Server 
Management Studio.  It is installed with all editions of SQL Server 2005 and later. 

By using the scripts described in the previous section, it is possible to perform database backups from the command 
line with the sqlcmd utility.  These commands can be entered freehand or can be added to a SQL batch file. 

The sqlcmd utility takes numerous optional arguments.  At a minimum, the ―-S‖ argument will be needed to access the 
SQL Server instance for Camtasia Relay.  Without any additional arguments, this will log you into the Relay instance 
with the current user‘s Windows credentials.  The optional ―-U‖ and ―-P‖ arguments can be added to the command line 
in order to provide SQL user credentials. 

http://msdn.microsoft.com/en-us/library/ms186865.aspx
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An example of freehand backup via the command line 

 

An example of a backup performed using a SQL command file 

 

More information on the sqlcmd utility can be found at: http://msdn.microsoft.com/en-us/library/ms162773.aspx 

Schedule an Automated Database Back Up 
Scheduled automated backups of the Camtasia Relay database can be performed in at least three ways: 

 Third-party backup utilities 

 SQL Server Automated Administration 

 Windows Scheduled Task 

Third-Party Backup Utilities 

If your organization has implemented a third-party backup system such as Symantec Backup Exec then you may 
have the option of integrating SQL Server backups of your Camtasia Relay database into that system.  The use of 
such a system may incur additional licensing costs for the software to perform this type of backup.  Performing 
backups in this manner will not be covered in the document but information on what databases to include can be 
found in the Backing Up Your Camtasia Relay Database section of this document. 

SQL Server Automated Administration 

Configuring automated backups via SQL Server Automated Administration is an option for all editions of Microsoft 
SQL Server except Express Edition due to its reliance on the SQL Server Agent service.  Camtasia Relay is 
distributed with SQL Server Express Edition for its standalone install. 

Scheduled backups on those editions of SQL Server supporting this capability can be created by building and 
scheduling a Database Maintenance Plan. 

Information on using Automated Administration for SQL Server can be found here: 
http://msdn.microsoft.com/en-us/library/ms189880.aspx 

Information on creating a SQL Server Maintenance Plan can be found here: 
http://msdn.microsoft.com/en-us/library/ms189953.aspx 

http://msdn.microsoft.com/en-us/library/ms162773.aspx
http://msdn.microsoft.com/en-us/library/ms189880.aspx
http://msdn.microsoft.com/en-us/library/ms189953.aspx
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Windows Scheduled Task 

For installations of Microsoft SQL Server Express Edition, the preferred method of performing an automated database 
backup is to utilize the Windows Task Scheduler.  One or more scheduled tasks can be configured to run the sqlcmd 
utility with a SQL command file as explained in the Backup Using the Command Line section of Backing Up the 
Camtasia Relay Database in this document. 

In order to run a SQL Server database backup via the Windows Task Scheduler, consideration must be made for 
whom to run the task as and what access this user has to the installed SQL Server instance.  If the sqlcmd utility is 
run without defining the SQL login username (-U) and password (-P) arguments, the scheduled task must be 
configured to run under a Windows account with permissions to run tasks on Windows and with access to back up the 
SQL Server database. 

 

To access Task Scheduler: 

 Using the Windows interface: 

a. Click the Start button. 

b. Click Control Panel. 

c. Click System and Maintenance. 

d. Click Administrative Tools. 

e. Double-click Task Scheduler. 

 From the Command Line: 

a. Open a command prompt. (To open a command prompt, go to Start > All Programs > Accessories> 
Command Prompt.) 

b. At the command prompt, type Taskschd.msc. 

For information on setting up a scheduled task in Windows Server, open the Task Scheduler Help. 

Restore the Camtasia Relay Database 
The Camtasia Relay database can be restored from a backup that was created using any of the methods described in 
the Back Up the Camtasia Relay Database section of this document.  Users of a third-party backup application will 
need to consult their backup software‘s documentation for restore procedures. 
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The procedures that follow describe a database restore to a SQL Server that previously contained the Camtasia 
Relay database.  Restoring to a new server installation requires additional steps to generate logins for the 
database.  If restoring to a new server, please first run a new installation of Camtasia Relay before restoring the 
database backup file or contact Customer Support for additional assistance. 

If a functioning database exists on the SQL Server but you wish to overwrite this database, it is generally a good 
practice to back up the existing database prior to overwriting it with a restore.  Directions on performing the backup 
can be found in the Back Up the Camtasia Relay Database section of this document. 

Restore Using SQL Server Management Studio 
To restore a database backup file using SQL Server Management Studio: 

1. Place the backup file in a folder on the database server that can be locally accessed by SQL Server.   

2. Open SQL Server Management Studio. 

3. Right-click the existing database or Databases (if restoring to a new database) and select  
Tasks > Restore > Database. 
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4. Set the database name to restore.  Select From Device and click … to select the backup file. 

 

5. Click Add to select the location of your database backup file.  Click OK. 
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6. Set Restore options to overwrite the database (if applicable), restore files to correct path, and Leave the database 
ready to use.  Click OK. 

 

The database has been successfully restored. 

 

More information on restoring databases from SQL Server Management Studio can be found here: 
http://msdn.microsoft.com/en-us/library/ms177429.aspx 

More information on how to Create a New Database From an Existing Database Backup can be found at: 
http://msdn.microsoft.com/en-us/library/ms186390%28SQL.90%29.aspx 

http://msdn.microsoft.com/en-us/library/ms177429.aspx
http://msdn.microsoft.com/en-us/library/ms186390(SQL.90).aspx


Camtasia Relay   Technical Reference Guide 

www.techsmith.com  80 

Restore Using a SQL Script 
A restore from a backup file can be scripted for use in a SQL batch file, freehand execution via SQL Query Editor or 
sqlcmd, or use in an external application. 

The following example script performs a database restore from a full backup of the Relay20 with the same options 
listed in the previous section Restore Using SQL Server Management Studio on page 77. 

RESTORE DATABASE Relay300 

 FROM DISK = 'C:\Program Files\Microsoft SQL 

Server\MSSQL10_50.RELAY\MSSQL\Backup\Relay300.bak' 

 WITH REPLACE, 

 RECOVERY; 

GO 

Please refer to the earlier section Back Up Using the Command Line on page 74 for more information on executing 
this script with the sqlcmd utility. 

More information on the RESTORE command can be found here: 
http://msdn.microsoft.com/en-us/library/ms186858.aspx 

Clean Up Old Databases 
Before attempting the following procedure, SQL Server Management Studio should be installed on your machine. 

 If you installed the Express Edition (default with the Camtasia Relay install), you can find this by visiting the 
following URL and searching for ―SQL Server Management Studio Express Edition‖: 
http://www.microsoft.com 

 If you have a full version of SQL Server 2005 or 2008, you can install SQL Server Management Studio from your 
SQL Server installation disc. 

To clean up old databases 

1. Back Up the Camtasia Relay Database (page 71). 

2. Right-click the database you want to remove and choose Delete. 

 

http://msdn.microsoft.com/en-us/library/ms186858.aspx
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3. Make sure that Close existing connections is enabled and click OK. 

 

 You do not receive a confirmation if the deletion succeeds. 

Troubleshooting 

On rare occasions, enabling Close existing connections does not close all of the open connections to the database 
and the deletion fails. If this happens, the database shows in the list with (Single User) next to it. 

When this happens, it‘s because the Camtasia Relay website is holding a connection to the SQL Server in order to 
help it cache data. 

If this occurs, stop the website in IIS. Doing so closes the open connection, and you can then delete the database. 
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Camtasia Relay Integrations 
The following subsections outline the various integrations that can be made with Camtasia Relay. 

Camtasia Studio and Camtasia for Mac Integration 
See the Camtasia Integration PDF found in the Camtasia Relay Learning Center 
(http://www.techsmith.com/learn/relay/default.asp). 

LDAP Integration 
This section describes how Camtasia Relay works with LDAP. 

Camtasia Relay LDAP Background 
Camtasia Relay has the ability to use LDAP, Lightweight Directory Access Protocol, for authentication of its users. 
The implementation within Camtasia Relay tries to follow the LDAPv3 standard as close as possible. 

There are a few ways that the Camtasia Relay server can connect to an LDAP server. We allow basic authentication 
and Microsoft Negotiate authentication. When connecting with basic authentication, credentials are sent over the 
network as clear text. Connections using Negotiate are both signed and sealed by default, providing an SSL-like 
connection without the use of certificates. There currently is no way to turn off the signing and sealing of a Negotiate 
connection. Both connection types can be used with SSL certificates if your LDAP server supports LDAPS, also 
known as LDAP over SSL. When LDAPS is used, no credentials are ever sent over the network as clear text. 

In most cases, Negotiate will be the authentication method of choice for organizations that use Active Directory, 
whereas Basic authentication applies mostly to servers running OpenLDAP, Novell eDirectory, and more. 

Most LDAP setups will use one of two ports for connections: 389 for the default; 636 if SSL is used. 

Connections are made to the LDAP server within your network (example: ldap.example.com). A sample Base 
Distinguished Name for this organization would might be DC=example,DC=com. Connections are made to the Base 
Distinguished Name on the LDAP server that you are connecting to. 

LDAP uses the analogy of forests and trees. When you are connecting to your Base Distinguished Name, you can 
imagine you are connecting to one tree within the forest. Therefore, all users and objects that you query will have to 
live within that tree. 

Authentication Method and Workflow 
Camtasia Relay‘s LDAP support was designed to reduce the amount of work for administrators and presenters. When 
using Camtasia Relay to authenticate with your LDAP store, there are two connections made. The first connection 
made to the LDAP server is to ask for the user‘s distinguished name. A distinguished name is a unique name within 
the LDAP server that represents the user/object. The distinguished name is then used in combination with the 
provided password to authenticate against the LDAP store. 

In the majority of cases with Negotiate authentication, the distinguished name is the same as the username that is 
provided. In this case, Camtasia Relay still makes a connection to search for the user before authenticating to 
determine if the user exists within the LDAP store before authenticating. This is done to provide better error messages 
for the administrator. The presenter will not see a different message whether their account exists or not. 

Once a distinguished name for a user is retrieved from the LDAP server, it is saved locally in the Camtasia Relay 
database. This reduces the need to search for the user‘s distinguished name at every subsequent authentication 
request. In the event that a user‘s distinguished name changes, Camtasia Relay will update its local copy of the 
distinguished name when the next authentication request is processed. 

After an authentication request is complete, the connection to the LDAP server is closed. 

http://www.techsmith.com/learn/relay/default.asp
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Certificate Handling 
When setting up Camtasia Relay, there is the option to use secure authentication (SSL) for securing the connection 
between the Camtasia Relay server and the LDAP server, often called LDAPS. SSL certificates provide two basic 
functions for securing a connection. First, the LDAP server can be authenticated and trusted to be the LDAP server 
that the Camtasia Relay was expecting to communicate with. Second, the communication between the Camtasia 
Relay server and the LDAP server will be encrypted and only these two servers can understand the messages sent 
back and forth. 

When using LDAPS, the certificate is verified before a successful connection can be made. In the event that the 
certificate could not be verified, a detailed error message will be shown explaining what may be causing the certificate 
handshake to fail. 

One of the most common error messages seen will be that of a root certificate that is not trusted, most likely stemming 
from the use of a self-signed certificate. To solve this, the root certificate can be imported to the Camtasia Relay 
server‘s computer account Certificate Store in the Trusted Root Certificate Authority. The public certificate of the 
LDAP server may need to be obtained from your organizations LDAP administrator to perform this step. 

If the errors found during verification of the certificate cannot be fixed, then the Camtasia Relay administrator may 
elect to ―Trust all certificates‖. This feature removes one of the two functions of SSL authentication. Communication 
between the two servers will stay encrypted but it will no longer be guaranteed that you are communicating with the 
LDAP server you intended. 

Adjust Search Depth Scope 
Depending on your LDAP tree, you may find it useful to limit how Camtasia Relay searches you LDAP tree for users. 
By default, Camtasia Relay will search the entire tree starting at and including the specified Base DN. Alternatively, 
Camtasia Relay can limit its search to searching one level deep into the Base DN, but not the Base DN itself. In order 
to change the search scope:  

1. Go to RelayConfig.aspx. 

2. Locate the LDAP Configuration section. 

3. Select the appropriate LDAP Search Depth Scope value from the dropdown list: 

 Subtree: Search the Base DN and all child objects. 

 One Level Deep: Search the child objects of the Basn DN, but not the Base DN itself. 

Error Message Details 
There are two times that LDAP errors may be seen: during the configuration of Camtasia Relay LDAP authentication 
and post-configuration. Most errors messages are written to provide enough help within the actual error message to 
provide a way for the Camtasia Relay administrator to repair the error. The following are error messages that may be 
seen and require longer explanation for causes. 
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 Invalid username and/or password. Please correct the credentials, verify the selected authentication method is 
correct, and try again. 

 If this error text is seen on the first step of the LDAP setup wizard, the user that is specified by the 
username/distinguished name field may not have been found. If there is no username/distinguished name entered 
in those fields, there may be one required by the LDAP server in order to connect. This is commonly referred to 
as an LDAP server that does not allow anonymous connections/queries. 

 The system was unable to verify your credentials with the authentication system. Please try again. 

 If this error text is seen on the login page for the Camtasia Relay website, then there was a problem connecting 
from the Camtasia Relay server to the LDAP server. This does not mean that the username/password 
combination is invalid. The LDAP configuration within Camtasia Relay may have not been configured correctly, or 
the LDAP server may be offline. 

 There was a problem browsing the directory tree. You may continue to import Users by searching for them. 

 If this error text is seen on the Import LDAP User page, then there was a problem connecting to, or traversing the 
LDAP tree. The LDAP configuration within Camtasia Relay may have not been configured correctly, or the LDAP 
server may be offline. 

RelayPresenter Service Account 
Prior to configuring Camtasia Relay to work with LDAP, we recommend creating a ―RelayPresenter‖ service account 
in your LDAP directory and associate this account when you bind credentials in LDAP. Use this account to perform 
the initial step in authenticating users. 

When a user tries to authenticate over LDAP, Camtasia Relay uses this ―RelayPresenter‖ user to search the LDAP 
directory and retrieve the user‘s qualified domain name. The user‘s qualified domain name is given to the LDAP 
directory along with their password for authentication. 

Camtasia Relay never stores LDAP passwords with the exception of the password of this service account. 

 The service account should have a password that does not expire. Camtasia Relay authentication will cease to 
function for all LDAP users, if the password of the service account in LDAP is not the same as the password 
stored in the Camtasia Relay database. 
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Advanced Configuration 
 The configuration options and tips and tricks found in this section are not officially supported by TechSmith 
Corporation.These configuration options are provided to give some added flexibility to customers but are NOT 
features of Camtasia Relay and therefore are not supported by TechSmith.  Before you modify any website files, 
make a backup of the originals as indicated.  The TechSmith support staff cannot provide assistance with these 
procedures.  Also, the Camtasia Relay server website can and will likely change in upcoming versions.  Make 
sure to backup your customizations before applying any updates to your Camtasia Relay system. 

More Accurate Transcription 
This section contains information on how to help the accuracy of the transcription of presentation audio for use in full 
audio search of Flash and Silverlight encodings and XML files. 

Audio Quality Considerations 
Our testing has shown that the best transcriptions occur when: 

 The presenter speaks naturally, 

 The signal quality is good (i.e. the recording is not overly noisy), and 

 The recording is not overly loud to the point of distortion. 

The last point is particularly important. 

The transcriber can transcribe quiet audio with only a small decrease in accuracy, but if the recording distorts because 
it is too loud (i.e. the audio meter in the Camtasia Relay Recorder is in the red), transcription accuracy will drop 
dramatically. 

Language Models 
When transcribing, Camtasia Relay uses a ―base language model‖ which was created using news broadcasts.  As it 
transcribes new audio files, it compares the sounds in the audio file against the phrases that it knows in the base 
language model.  It uses those comparisons to create the transcribed text. 

Custom Language Models 

Since the base language model does not anticipate phrases that are not typically used in a news broadcast, Camtasia 
Relay also builds a custom language model for each presenter. 

These custom language models come from the slide content sent alongside presentations.  If a presenter plays a 
slideshow in Powerpoint or Keynote while recording their presentation, the text on the slides (including the invisible 
―notes‖ on the slides) will be used to build the custom language model.  This means that presenters with slides that 
contain the same words that they speak in their presentation enjoy increased transcription accuracy. 

Captions edited and saved though Relay's caption editor are also saved on the server to help aid future transcriptions. 

Camtasia Relay also keeps the custom language model for a presenter on its server so that subsequent presentations 
also gain the benefits of the slides sent with prior presentations. 

How Presenters Can Help 

A presenter – if they want to go that far - can build a custom language model for themselves by typing up a literal 
transcription of a presentation that they have previously done and sending it to Camtasia Relay in the form of 
slideshow text.  Camtasia Relay will then have a model of their speech patterns for subsequent presentations. 
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 The transcriber works based on predicting the phrases that a presenter is likely to say.  ―Teaching‖ the transcriber 
by having presenters read a canned presentation only serves to increase the likelihood that the phrases in the 
canned presentation are transcribed accurately. 

How Administrators Can Help 

Administrators can assist the transcription process on a per-user basis by copying files into the users‘ directories in 
the server‘s LanguageModelCache directory, which resides inside the server‘s Media directory. Camtasia Relay 
stores the text that assists the language model builder in this directory. 

Administrators with access to the server can move an ASCII or UTF-8 encoded text file into a user‘s subdirectory 
within the LanguageModelCache directory and the language model builder will consume that text when it transcribes 
presentations for that user. Too seed all of the users at once, files may be placed in the AllUsers directory which is 
locacted under the LanguageModelCache directory. 

 If you have multiple Relay Servers in a teamed configuration, this step needs to be performed on each of the 
servers separately. 

 The users‘ subdirectories do not have to be created by the transcription process.  If you know what a user‘s ID is, 
you can assist their presentation transcriptions ―in advance‖ by creating a subdirectory for them and moving text 
files with pertinent text into it. 

Configuring Automatic Redirects to the Camtasia 
Relay Website 
When Camtasia Relay is installed on a server, it is strongly encouraged that it be the only website on the server.  If it 
is the only website on a server, you can configure the server so that the user may visit the site URL and be redirected 
to the Camtasia Relay website. 

Example 

On the TechSmith RelayDev05
1
 server, visiting http://relaydev05.techsmith.com with a web-browser shows the 

following page: 

 

Making the changes shown in the following instructions results in a URL like http://relaydev05.techsmith.com being 
automatically redirected to http://relaydev05.techsmith.com/Relay to show the Camtasia Relay website. 

                                                      

1
 This server is not available outside of the TechSmith network. 
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IIS 7 Instructions (Windows Server 2008) 
Official instructions for creating a website redirection in IIS7 can be found at: 
http://technet.microsoft.com/en-us/library/cc732930%28WS.10%29.aspx 

Official instructions for enabling HTTP Redirection capability in IIS7 can be found at: 
http://www.iis.net/ConfigReference/system.webServer/httpRedirect 

The ability to create an HTTP Redirection is not installed by default for IIS7.  If you do not see the option available in 
the IIS Manager, follow the instructions in the link shown above. 

1. Open the IIS Manager. 

2. Select the website that contains the Camtasia Relay virtual directory. 

3. Click HTTP Redirect. 

 

4. Click Redirect requests to this destination. 

5. Type the name of the Camtasia Relay virtual directory subdirectory.  (/Relay) 

6. Click Only redirect requests to content in this directory (not subdirectories). 

7. Click Apply. 

http://technet.microsoft.com/en-us/library/cc732930(WS.10).aspx
http://www.iis.net/ConfigReference/system.webServer/httpRedirect
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8. Test the redirect in a web-browser after making these changes by visiting the Fully Qualified Domain Name of the 
system. 

IIS 6 Instructions (Windows Server 2003) 
Official instructions for creating a website redirection in IIS6 can be found at: 
http://technet.microsoft.com/en-us/library/cc736641%28WS.10%29.aspx 

Instructions 

1. Open the IIS Manager. 

2. Right-click the website that contains the Camtasia Relay virtual directory. 

3. Click Properties. 

http://technet.microsoft.com/en-us/library/cc736641(WS.10).aspx
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4. Click A redirection to a URL. 

5. Type the name of the Camtasia Relay virtual directory (/Relay) into the Redirect to textbox. 

6. Click A directory below URL entered. 

7. Click the OK button. 
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8. Test the redirect in a web-browser after making these changes by visiting the Fully Qualified Domain Name of the 
system. 

Custom Bumper Videos 
During the Camtasia Relay trial, a 5-second ―bumper video‖ is added to both the beginning and end of the 
presentations to indicate the server is in a trial mode. 

Some customers have requested the ability to append their own videos to the beginning and end of presentations 
after purchase.  While this is currently not a supported feature, you can add bumper videos, provided that the 
following conditions are acknowledged: 

 The video will be added at both the beginning AND end of all presentations. 

 Only one video can be used for ALL presentations sent through the system. 

 The bumpers will ALWAYS be applied.  There will be no option to not apply the bumper video. 

If all of those options are acceptable and you wish to ―brand‖ your videos with a bumper video: 

1. Create a bumper video that uses TechSmith TSCC codec.  The video must be 10fps and be in AVI format. 

 You can use Camtasia Studio from TechSmith to create and export in this format. 

2. Export the video into 4 different resolutions: 320x240, 640x480, 800x600, and 1024x768. 

3. Go to [install dir]\TechSmith\Relay Server\Manager\ and create a new folder called 

bumpervideos. 
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4. Copy the following default bumper videos into the new folder: 

 320trialmode.avi 

 640trialmode.avi 

 800trialmode.avi 

 1024trialmode.avi 

5. Copy your videos over the bumper videos using the respective naming. 

6. Run the following SQL statement against the Relay database. 

INSERT INTO Relay.dbo.tblConfig (confName, confValue) 

VALUES('UseBumperVideos', 'True') 

For more information, see Running SQL Statements on page 102. 

7. Send a sample presentation through the system to ensure the bumper videos are added correctly. 

HTML Container Customizations 

 Be sure to make backups of all files before you make any edits.  If these files are corrupted in any way, this can 
cause your Web Outputs to fail.  Also take special care when modifying the Flash or Silverlight object code in the 
html. 

The following files are the HTML containers for both the Silverlight/WMV output and the Flash/MP4 output.  These 
HTML containers can be modified if there is a consistent look and feel that you want to follow with these containers. 

[installdir]\TechSmith\Relay Server\Manager\Media\silverlight_index.html 

[installdir]\TechSmith\Relay Server\Manager\Media\swf_flv_index.html 

HTML Container Variables 
In the files mentioned above, there are a few variables that get used to refer to some strings that that server uses 
when making replacements in the code.  It replaces these variables with their string equivalents: 

 $MovieName is replaced with the movie name 

 $MovieWidth is replaced with the movie width 

 $MovieHeight  is replaced with the movie height 

Example 
If you wanted to provide a download link at the bottom of the page to the source video you could include the following 
code before the </body> tag: 

Flash 

<div><a href="$MovieName.mp4" style=”color: #fff;”>Click here to download this 

video.</a></div> 

Silverlight 

<div><a href="$MovieName.wmv" style=”color: #fff;”>Click here to download this 

video.</a></div> 

Branding the Camtasia Relay Website 
Branding the Camtasia Relay website requires some basic knowledge of Cascading Style Sheets.  This document 
outlines some of the most important styles that can be overwritten for the website to be branded according to your 
needs. 
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The Process 
Rebranding the Camtasia Relay involves the following steps. 

1. Create the following directory and copy the graphics you would like to use into the directory. 

[install dir]\TechSmith\Relay 

Server\Web\App_Themes\Standard\8_CustomStyles\images 

2. Make a copy of the following file and directory and move the file copy to the directory. 

[install dir]\TechSmith\Relay 

Server\Web\App_Themes\Standard\8_CustomStyles\custom.css 

[install dir]\TechSmith\Relay Server\backups\ 

3. Edit the following file to point to the new graphics. 

[install dir]\TechSmith\Relay 

Server\Web\App_Themes\Standard\8_CustomStyles\custom.css 

4. Review the changes. 

The CSS Properties 
The following properties are those that you will likely need or want to change to make these modifications. 

background-image: url(‘images/image.png’); 

background-position: top left; 

background-color: #eee; 

width: 200px; 

height: 50px; 

top: 5px; 

right: 10px; 

bottom: 0px; 

left: 20px; 

The Styles 
Header Logo 

 

The logo in the header can be modified to include your own logo. 
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#layout_logo 

{ 

 width: 229px; 

 height: 44px; 

 position: absolute; 

 background: url('../images/sprites/relay.sprite.1.2.0.png') no-repeat -36px -

2px; 

 left: 0px; 

 top: 13px; 

} 

It is recommended that you keep the image height of 55 pixels or less so as not to stretch out the header. 

Footer 

 

The footer can be modified to include additional content.  TechSmith does however highly recommend that you not 
change or affect the product information in the lower right corner. 

#footer 

{ 

 color: #777777; 

 font-size: 0.75em; 

 height: 40px; 

 line-height: 0.8em; 

 margin-bottom: 15px; 

 padding-right: 5px; 

 padding-top: 9px; 

 text-align: right; 

} 

It is recommended that you keep footer graphics under 30 pixels tall. 
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Login Page 

 

The login page is primarily one large background graphic.  To change the look of this page you may wish to start with 
the graphic and make necessary modifications to it, and then save a copy of it into your images directory as a 
replacement. 

#login_area 

{ 

 background-image: url(../Images/Layout/login_page.png); 

 background-position: left top; 

 background-repeat: no-repeat; 

 height: 400px; 

 position: relative; 

 width: 980px; 

} 

The #greenbar element may also require modification. 

Recorder Download Page 

 

.largeRelayText 

{ 
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 background-image: url(../images/layout/large_relay_text.png); 

 background-repeat: no-repeat; 

 height: 77px; 

 margin-left: 20px; 

 margin-right: 50px; 

 width: 409px; 

} 

CSS Resources and Tools 
W3Schools.com 

  

http://www.w3schools.com/default.asp 

Free resource that can help you learn various web programming languages like CSS.  To better 
understand the properties listed in the ―CSS Properties‖ section, please refer to this website. 

Firebug Add-on 
for Firefox 

  

http://getfirebug.com/ 

Can help youeasily determine which of the stylesheets that Camtasia Relay uses, or which 
style, is causing the behavior you view in the website. It allows you view overriding CSS values 
without actually modifying the files.   

Aardvark Add-on 
for Firefox 

  

https://addons.mozilla.org/en-US/firefox/addon/4111 

The Aardvark add-on was used during the creation of the screenshots you see for these website 
screenshots.  It enables you to quickly review HTML elements and their names when viewing a 
website. 

 

Sample Configuration CSS File 
/* 

All of the following styles were created for the purposes of branding the Camtasia Relay 

website.  The images for these styles are stored in the following directory... 

c:\Program Files\TechSmith\Relay Server\Web\App_Themes\Standard\8_CustomStyles\images 

*/ 

 

/* Replace the Logo in the header with one that fits the institution */ 

 #layout_logo 

 { 

  background-image: url('images/logo.png'); 

  background-position: top left; 

  width: 350px; 

  height: 55px; 

  top: 8px; 

 } 

 

/* Make some small changes on the login page to add recognizable institution graphics */ 

 #login_area 

 { 

  background-image: url('images/login.png');*/ 

 } 

 

/* Make a change to the graphic on the recorders download page */ 

 .largeRelayText 

 { 

  background-image: url('images/largelogo.png'); 

  background-repeat: no-repeat; 

  width: 335px; 

  height: 520px; 

  margin-left: 20px; 

  margin-right: 50px; 

 } 

http://www.w3schools.com/default.asp
http://getfirebug.com/
https://addons.mozilla.org/en-US/firefox/addon/4111
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/* Add a small graphic to the footer */ 

 #footer 

 { 

  background-image: url('images/smalllogo.png'); 

  background-position: top left; 

  background-repeat: no-repeat; 

  height: 30px; 

 } 

MIME Types on Servers 
MIME types (Internet media types) are how file formats are identified on the Internet. Your web browser uses these 
MIME types to be able to use file formats that are not HTML. A media type is has two parts: a type and a subtype. 
Types can be application, audio, image, message, model, multipart, text. The Subtype are the extensions such as for 
type image the subtype is jpeg (image/jpeg) or for type audio a subtype is mp4 (audio/mp4). The MIME types that 
your server can provide are set by IIS or Apache not inside Relay. 

List of available MIME types from IANA: 
http://www.iana.org/assignments/media-types 

 The hosting of the Camtasia Relay generated outputs is not a function of the Camtasia Relay server.  These 
instructions are provided to help administrators make these changes on the media server.  This should not be the 
same machine as the Camtasia Relay server. 

IIS 

 MIME types in IIS (reference list of MIME types on bottom of page): 
http://technet.microsoft.com/en-us/library/bb742440.aspx 

 How to add a MIME type in IIS 7.0: 
http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx 

 How to add a MIME type in IIS 6.0: 
http://technet.microsoft.com/en-us/library/cc786786(WS.10).aspx 

Apache 

Apache MIME Module: 
http://httpd.apache.org/docs/2.2/mod/mod_mime.html 

In apache the server is based on configuration files you can either specify these in the main configuration file or you 
can create a secondary file that hold all your MIME types separately by putting a ―TypesConfig‖ Directive in the main 
configuration file. The TypesConfig Directive accepts a file path which contains a configuration file of MIME types. 

 To specify the file path for the MIME configuration file: 

TypesConfig file-path 

 To add MIME types to your configuration files you need too add them in the format: 

AddType [MIME-type extension] [extension] 

 EXAMPLE 

AddType mp4 video/mp4 

Once you have updated your configuration files you can check to make sure all your configuration is working properly 
before restarting apache and implementing the configuration by: 

Apachectl configtest 

or 

http://www.iana.org/assignments/media-types
http://technet.microsoft.com/en-us/library/bb742440.aspx
http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc786786(WS.10).aspx
http://httpd.apache.org/docs/2.2/mod/mod_mime.html
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httpd –t 

XML and CONFIG Files on the Server 
The following list shows the paths and descriptions of the .XML and .CONFIG files on the Camtasia Relay server. 

 Server Log File Modifications 

 Web Log File Modifications 

C:\Program Files\TechSmith\Relay Server\Web\web.log4net.config 

Sets the logging levels for the Relay Administration Website. Logs, by default go to <RelayInstallDir>\Logs but 
they may be configured to go to a different directory. 

<file value="C:\Program Files\TechSmith\Relay Server\Logs\WebDebug.log"/> 

<file value="C:\Program Files\TechSmith\Relay Server\Logs\WebError.log"/> 

By default, 10 logfiles each are maintained for web debugging and web errors.  Each logfile can contain up to 10 
Megabytes of data before a new logfile is started.  Once the 11

th
 logfile is begun, the oldest logfile is automatically 

deleted from the system.  To change these values and retain more or less data, use these settings (note that the 
settings for debug logging and error logging can be set independently): 

<maximumFileSize value="10MB"/> 

<maxSizeRollBackups value="9"/> 

By default debug logging is turned off, and only errors are written there.  Generally, when website errors are 
written to these files, they are also written to the server‘s Event Log.  However, these logs generally contain more 
information than the terse event log entries do.  Customers may opt to enable debug logging by changing the file 
like so: 

<appender-ref ref="DebugAppender"/> 

<appender-ref ref="ErrorAppender"/> 

Note that doing this has shown to degrade system performance, particularly in the area of disk I/O.  Changes to 
the logging settings are dynamic and take effect immediately without restart of any services or the server. 

 Database Connection Information - Website 

C:\Program Files\TechSmith\Relay Server\Web\web.config 

Information contained in this file is pertinent to the Relay Administration Website.  Generally customers should not 
need to modify this file.  One piece of information that may be of interest to customers is the Relay Database 
Connection string. Please see the ―Migrating from one SQL Server to Another‖ section for more information: 

<connectionStrings> 

 <add name="RelayConnectionString" connectionString="Data Source=server\RELAY; Initial 

Catalog=Relay20; User Id=Relay; Password=RelayPassword Pooling=True;" /> 

</connectionStrings> 

 Database Connection Information – Manager Service 

C:\Program Files\TechSmith\Relay Server\Manager\data.config 

This file contains the database connection string that the Relay Manager Service uses to communicate to the 
database. The transcriber, encoder, publisher, and notifier processes also utilize this connection string.  If the 
connection string is changed in this file, it must also be changed in the website‘s web.config file as well. Please 
see the ―Migrating from one SQL Server to Another‖ section for more information. 

<add name="RelayConnectionString" connectionString="Data Source=server\RELAY; Initial Catalog=Relay20; 

User Id=Relay; Password=RelayPasswd Pooling=True;"/> 

 Server Endpoint Information 

C:\Program Files\TechSmith\Relay Server\Manager\endpoint.config 

The data in this file associates a particular Camtasia Relay server instance with a row in the endpoint table in the 
database.  Customers typically will not need to modify this file. 

C:\Program Files\TechSmith\Relay Server\Manager\manager.log4net.config 
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Sets the logging levels for the Relay Manager Service. Logs, by default go to <RelayInstallDir>\Logs but 

they may be configured to go to a different directory. 

<file value="C:\Program Files\TechSmith\Relay Server\Logs\ManagerDebug.log"/> 

<file value="C:\Program Files\TechSmith\Relay Server\Logs\ManagerError.log"/> 

By default, 10 logfiles each are maintained for manager service debugging and manager service errors.  Each 
logfile can contain up to 10 megabytes of data before a new logfile is started.  Once the 11

th
 logfile is begun, the 

oldest logfile is automatically deleted from the system.  To change these values and retain more or less data, use 
these settings (note that the settings for debug logging and error logging can be set independently): 

<maximumFileSize value="10MB"/> 

<maxSizeRollBackups value="9"/> 

By default debug logging is turned off, and only errors are written there.  Generally, when manager service errors 
are written to these files, they are also written to the server‘s Event Log.  However, these logs generally contain 
more information than the terse event log entries do.  Customers may opt to enable debug logging by changing 
the file like so: 

<!--COMMENT THE FOLLOWING LINE TO TURN OFF DEBUG (VERBOSE) LOGGING--> 

<appender-ref ref="DebugAppender"/> 

<appender-ref ref="ErrorAppender"/> 

Note that doing this has shown to degrade system performance, particularly in the area of disk I/O. Changes to 
the logging settings are dynamic and take effect immediately without restart of any services or the server. 

 Manager Service Configuration File 

C:\Program Files\TechSmith\Relay Server\Manager\manager.exe.config 

Information contained in this file is pertinent to the Relay Manager Service.  Generally customers should not need 
to modify this file. 

 Notification Process Configuration File 

C:\Program Files\TechSmith\Relay Server\Manager\RelayNotifier.exe.config 

Information contained in this file is pertinent to the Relay Notification Process.  Generally customers should not 
need to modify this file. 

 Encoder Process Configuration File 

C:\Program Files\TechSmith\Relay Server\Manager\RelayEncoder.exe.config 

Information contained in this file is pertinent to the Relay Encoder Process.  Generally customers should not need 
to modify this file. 

 Publisher Process Configuration File 

C:\Program Files\TechSmith\Relay Server\Manager\RelayPublisher.exe.config 

Information contained in this file is pertinent to the Relay Publisher Process.  Generally customers should not 
need to modify this file. 

 Transcriber Process Configuration File 

C:\Program Files\TechSmith\Relay Server\Manager\RelayTranscriber.exe.config 

Information contained in this file is pertinent to the Relay Transcriber Process.  Generally customers should not 
need to modify this file. 
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Security 
The Security of the Camtasia Relay system is an important topic worthy of its own guide.  The Camtasia Relay 
Server Security Administrator Guide contains a large variety of security related topics such as 

 SSL 

 Reducing Attack Surface 

 Segregation of Duties 

 Strong Passwords 

 Server Hardening 

 Firewall Rules 

 And the various Security Features built into Camtasia Relay itself 

A link to the Security guide and other resources can be found in the Appendix A: Additional Help and Related 
Documentation on page 104. 
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TechSmith Sales Support 
For pre-sales activities, activation information, licensing information, and other sales related questions, please call our 
Sales team. 

 The following information is available on the TechSmith website by clicking Company > Contact Us.  Always 
refer to that location for latest, most accurate information. 

Sales:+ 1.517.381.5901 

Toll Free in the U.S. & Canada:888.750.0685 

Sales Contact Form: http://www.techsmith.com/company/contact/salescontact.asp 
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TechSmith Tech Support 
In the event you have an issue that cannot be answered with the Camtasia Relay Help and documentation, please 
follow the steps below when working with TechSmith Tech Support. 

Step 1: Knowledge Base Search 

Before contacting TechSmith for Technical Support, please make sure to search the Knowledge Base on the Support 
Center (http://support.techsmith.com). It is possible that the issue is a known issue and there is already an answer 
available. 

Before running a search, select Camtasia Relay and the version number in the dropdown lists. 

 

Step 2: Submit a Question 

If you are unable to find an answer to your issue, you can send a question to Tech Support. 

1. On the Support Center page (http://support.techsmith.com), click Ask a Question. 

 

2. Fill in the requested information, making sure to select your current Product Version, Operating System, and 
Problem Type. 

 For a question regarding a program error, please select Other under Problem Type. 

3. If you are a first-time user, you are prompted to create a user account. 

Tips for Submitting a Question 

 When opening a support ticket, please include as much information regarding the nature of the problem as 
possible. 

 To speed up the debugging process, attach one or more of the following to the support ticket: 

 Screenshots 

 Application logs 

 Other diagnostic information 

http://support.techsmith.com/
http://support.techsmith.com/
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 Event Viewer logs 
These are particularly useful. The steps in How to Export Event Viewer Logs on page 36 explain how to 
export the logs for Camtasia Relay components. 

Step 3: Call Tech Support 

The Camtasia Relay Tech Support team is ready and waiting for your questions.  Should you have problems that you 
cannot solve using the resources provided, please give us a call and we will be happy to assist. 

 The following information is available on the TechSmith website by clicking Company > Contact Us.  Always 
refer to that location for latest, most accurate information. 

Phone:+1.517.381.2300 (ext. 784) 

Toll Free in the U.S. & Canada: 800.517.3001 (ext. 784) 

Tech Support Website: http://support.techsmith.com 

Running SQL Statements 

During calls with TechSmith Technical Support or additional configuration of the system, it may be necessary to run 
Transact SQL (T-SQL) statements against this database. 

To do this, we recommend the following: 

1. Install SQL Server Management Studio Express. 

 If you installed the Express Edition (default with the Camtasia Relay install), you can find this by visiting the 
following URL and searching for ―SQL Server Management Studio Express Edition‖: 
http://www.microsoft.com 

 If you have a full version of SQL Server 2005 or 2008, you can install SQL Server Management Studio from 
your SQL Server installation disc. 

 Camtasia Relay supports SQL Server Management Studio Express 2005 SP2 or 2008 SP1. Management 
Studio can be setup and attached for local or remote management (depending on network and machine 
settings) of the relay database. 

2. Connect to the database either using SQL Server Authentication or Windows Authentication.  
The authentication method largely depends on how the SQL Server was configured.  Your Relay instance will 
have a login of ―Relay‖ and a password that was supplied during the installation of Camtasia Relay. 

 

3. Click the ―New Query‖ button to open a new query. 

http://support.techsmith.com/
http://www.microsoft.com/
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4. Make sure you select the ―Relay20‖ database from the database dropdown list. 

 

5. Type or paste the SQL statement into the window that then hit Execute or press the F5 key. 
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Appendix A: Additional Help and Related 
Documentation 
We hope you have found this Technical Reference Guide helpful, but it is only one of many help resources available 
to you as a user of Camtasia Relay. The following are some additional resources for you as use the Camtasia Relay 
product. 

Feedback 

If you would like to offer feedback on or suggestions of topics to cover in this or any other Camtasia Relay 
documentation, please send an email to relayhelp@techsmith.com. 

Camtasia Relay Website and Recorder Help 
For day-to-day administration of Camtasia Relay, please see the Camtasia Relay Website Help. This help is available 
after logging into the Camtasia Relay website as an administrator. Just click a Help link, available on each web page, 
to open the Camtasia Relay Administrator Help. 

For help with the Camtasia Relay recorder, please install and open the Camtasia Relay recorder or open the portable 
recorder to access help for the recorder. 

    

Related Documentation 
The following PDF documents are available for download from the TechSmith website: 

 Camtasia Relay Installation Guide  

Learn how to install the Camtasia Relay server. 

 Camtasia Relay Upgrade Guide  

Learn how to upgrade Camtasia Relay. 

 Camtasia Relay Administrator Website Help  

Walk through the configuration of Camtasia Relay and find administration information to help you keep Camtasia 
Relay running smoothly 

 Camtasia Relay Server Security Administrator Guide  

Learn about ways to help secure your Camtasia Relay server. 

 Camtasia Relay Release Notes  

See a summary of the new features and updates. Learn about how those features affect current users. 

TechSmith Learning Center 
The TechSmith Learning Center contains a wealth of free resources for each one of TechSmith‘s products, including 
Camtasia Relay.  We encourage you to visit the site, choose the section that most interests you and then watch a 
video or read an article. 

mailto:relayhelp@techsmith.com
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
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The Camtasia Relay Learning Center is available at: 
http://www.techsmith.com/tutorial-camtasia-relay.html 

http://www.techsmith.com/tutorial-camtasia-relay.html
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Appendix B: Glossary 
  

A 
AVI 

Audio Video Interleave, (AVI), is a multimedia format introduced by Microsoft. 

Attack Surface 

In a web environment, Attack Surface refers to those components that are available to unauthenticated users. 

Authentication 

In a web environment, the method designed to allow a browser or other program to provide a user name and 
password as credentials when making a request. 

B 
Blackboard 

In the context of this manual, Blackboard refers to the Blackboard Application Suite of e-learning software products 
from Blackboard, Inc. 

Building Blocks 

In the Blackboard Application Suite of software products, an extension to the standard suite that can be separately 
installed. 

C 
Camrec 

A multimedia format developed by TechSmith Corporation. 

Camtasia Relay 

A software product for lecture capture from TechSmith Corporation. 

Camtasia Studio A video recording and editing software product from TechSmith Corporation. 

CAPTCHA 

Acronym for Completely Automated Public Turing test to tell Computers and Humans Apart‖. A type of ―challenge-
response‖ test in which a computer asks a user question to ensure that the response is not being generated by a 
computer. 

Certificate Authority or Certification Authority 

A trusted third party entity  
such as VeriSign -- that issues digital certificates to be used as part of a security plan. 

D 
DMZ 

DeMilitarized Zone also called Data Management Zone, is a part of a network that contains and exposes an 
organization's external services to a larger network, usually the Internet. 

DTC 



Camtasia Relay   Technical Reference Guide 

www.techsmith.com  107 

The Microsoft Distributed Transaction Coordinator (DTC or MSDTC) service is a component of Microsoft 
Windows that coordinates transactions that span multiple resource managers, such as databases, message queues, 
and file systems. 

Dynamic Port 

One from a set of predefined private port numbers to be used for communications between applications using the 
Internet's Transmission Control Protocol (TCP) or the User Datagram Protocol (UDP). 

E 
Encode 

In the context of this document, the process of converting a media recording from one format into another. 

F 
Firefox 

an open source browser available from Mozilla Corporation. 

Firewall 

That part of a computer network designed to block unauthorized access while permitting authorized communications. 

Flash 

A multimedia platform from Adobe Systems, Inc, Flash is often used to add animations and video to web pages and 
rich internet applications. 

FTP 

File Transfer Protocol is a network protocol used to exchange files between computers or over the internet. 

G 
Group ID or Media Group ID 

A 10-digit number used iTunes U to direct produced media to a specific instructor‘s class. 

I 
IIS 

Internet Information Services from Microsoft, Corporation is a set of internet-based services used within Microsoft 
Windows and including FTP, FTPS, SMTP, NNTP and HTTP/HTTPS. 

iPod 

is a brand of portable media player designed and marketed by Apple Corporation. 

IPSec 

Internet Protocol Security is a suite protocols for securing communications on the Internet. 

J 
Jing 

A software product from TechSmith Corporation for capturing screen and video images. 
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K 
Keynote 

In the context of this document, a software product for creating and producing presentations from Apple Corporation. 

KMS 

Key Management Service from Microsoft Corporation is used to activate computers running Windows Vista and 
Windows Server 2008. 

L 
LDAP 

Lightweight Directory Access Protocol is an application protocol for querying and monitoring directory services running 
over TCP/IP. 

LDAPS 

Is Lightweight Directory Access Protocol implemented over a Secure Sockets Layer (SSL). 

Leopard 

The code name for the operating system Mac OS X from Apple Corporation. 

M 
M4A 

an alternate file extension tag (to MP4) for MPEG-4 files. 

M4V 

an alternate file extension tag (to MP4). 

Media Group ID 

A 10-digit number used iTunes U to direct produced media to a specific instructor‘s class. 

Morae 

Usability testing software from TechSmith Corporation. 

MOV 

A multimedia format originally based on the QuickTime format from Apple Corporation. 

MPEG 

Moving Picture Experts Group a group formed by the International Organization for Standardization (ISO) to set 
standards for audio and video compression and transmission. 

MP3 

A patented digital audio encoding format. 

MP4 or MPEG-4 

A multimedia container format originally based on the QuickTime format from Apple Corporation. 

P 
PDF 

A file format created by Adobe Systems for document exchange. 

Port 443 
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The default port used by HTTPS (Hypertext Transfer Protocol Secure). 

Port 80 

The default port used by HTTP (Hypertext Transfer Protocol). 

Portable Recorder 

In the context of this document, one of the options for using the Record portion of the Camtasia Relay lecture capture 
software product. Instead of installing the Record software on a computer, it can be loaded on to a portable device, 
such as a thumb drive. 

PowerPoint 

Software for creating and producing presentations from Microsoft Corporation. 

Presenter Account 

In the context of this document, an account within the Screencast media-hosting site from TechSmith Corporation to 
be used by people recording presentations using the software product Camtasia Relay. 

Production Preset 

Within the lecture capture software product Camtasia Relay, the ability to specify recording settings prior to making 
the recording. 

Profile for Camtasia Relay 

Within the lecture capture software product Camtasia Relay, a profile is used to specify publishing formats and 
destinations for presentations that are submitted for processing. 

Publish Destination 

Within the lecture capture software product Camtasia Relay, the destination that will hold the processed 
lecture including FTP servers, network drives (File system) iTunes U, and TechSmith‘s media-hosting site, 
Screencast.com. 

R 
Real Media 

A multimedia container format created by RealNetworks. 

S 
Safari 

A web browser that runs on computers from Apple Corporation. 

Screencast 

a media hosting site owned and operated by TechSmith Corporation. 

ScreenDraw 

In software products from TechSmith Corporation, the feature that allows the user to use the cursor to make freehand 
drawings on an image. 

SCW or Security Configuration Wizard 

A software component in Windows Server 2003 SP1 from Microsoft Corporation used to configure server security. 

Self-Signed Certificate 

In computer security, an identity certificate that is signed by its own creator as being legitimate. 

sFTP 

In computer security, Secure File Transfer Protocol (sFTP) refers to the practice of running normal FTP over secure 
shell connections. 
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Shared Secret 

In cryptography, a piece of information known only to the two parties involved in a secure communication. 

SmartFocus 

A tool within software products developed by TechSmith Corporation to intelligently zoom into specific areas of an 
image during screen capture. 

SMTP 

Simple Mail Transfer Protocol is an Internet standard for electronic mail transmission across Internet Protocol 
networks. 

Snagit 

A screen capture program developed by TechSmith Corporation. 

SPI or Stateful Packet Inspection 

A firewall that keeps track of the state of network connections traveling across it -- including as TCP streams and UDP 
communication. 

SQL Server 

Microsoft SQL Server is a relational model database server produced by Microsoft. 

SSL or Secure Sockets Layer 

(Replaced by Transport Layer Security (TLS)) A cryptographic protocol that provides security for communications over 
networks such as the Internet. 

Stateful Packet Inspection 

A firewall that keeps track of the state of network connections traveling across it -- including as TCP streams and UDP 
communication. 

T 
TCP 

Transmission Control Protocol is one of the core protocols of the Internet protocol suite. 

Tiger 

The code name for version 10 of the operating system used on Macintosh computer systems from Apple Inc. 

TLS or Transport Layer Security 

A cryptographic protocol that provides security for communications over networks such as the Internet. 

U 
UDP 

User Defined Protocol is part of the set of network protocols used to transmit information over the internet. 

Uploader 

The part of Camtasia Relay that transfers a completed lecture from the recorder to the server. 

W 
WAF 

A web application firewall (WAF) is an appliance, server plugin, or filter that applies a set of rules to an HTTP 
conversation. 

WebDAV or Web-based Distributed Authoring and Versioning 
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A set of extensions to the Hypertext Transfer Protocol (HTTP) that allows users to edit and manage files 
collaboratively on remote World Wide Web servers. 

Windows Media Video or WMV 

A proprietary compressed video format developed by Microsoft. 

Windows Portable Media Device 

A class of portable media devices that integrate directly with Windows Media Player. 

WMV or Windows Media Video 

A proprietary compressed video format developed by Microsoft. 

X 
XML or Extensible Markup Language 

A set of rules for encoding documents electronically. 

Y 
YouTube 

A video sharing website where users can upload and download videos. 

 

 


